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INTRODUCCIÓN

Fundamento teórico

Los métodos químico-cuánticos de estudio de la estructura molecular persiguen resolver la 
ecuación de Schrödinger independiente del tiempo de una molécula:

!  
donde ‘A’ representa las  coordenadas de los  núcleos e  ‘i’  las  de los  electrones.  Para ello  se 
recurre,  normalmente,  a  la  aproximación de Born-Oppenheimer,  que consiste en tomar como 
función de onda molecular el producto de una función electrónica por una función nuclear

�  

que se calculan en dos etapas sucesivas. En la primera se resuelve una ecuación de Schrödinger 
electrónica para posiciones fijas de los núcleos (A):

�  

Cada solución {Ψel,A(i), Eel,A} de esta ecuación representa un estado electrónico y, para cada uno 

de éstos, se puede proceder al estudio del movimiento de los núcleos resolviendo la ecuación de 
Schrödinger nuclear correspondiente:

�  

donde U(A) es la energía potencial efectiva que rige el movimiento de los núcleos (la “superficie 
de energía potencial”) para el estado electrónico considerado. Esta función se determina punto a 
punto  calculando  la  energía  electrónica  (Eel,A)  para  distintas  geometrías  nucleares  (A)  y 
sumándole la repulsión internuclear correspondiente (Vnuc(A)). Para un sistema de N núcleos, U 
depende de 3N–6 coordenadas independientes, salvo en el caso de las moléculas diatómicas que 
tienen una sola coordenada nuclear independiente: la distancia internuclear (R).

Objetivos generales

Las  prácticas  que  se  describen  a  continuación  consisten  en  resolver  la  ecuación  de 
Schrödinger electrónica de distintos sistemas para diferentes geometrías, interpretar los resultados 
de estos cálculos y determinar,  a partir  de la superficie de energía potencial  correspondiente, 
algunos  parámetros  relacionados  con  el  movimiento  nuclear.  En  algunos  de  los  problemas 
estudiados  se  determinarán  también  ciertas  propiedades  termodinámicas  utilizando  para  ello 
expresiones deducidas mediante los métodos de la termodinámica estadística.

Software a utilizar

Para  alcanzar  los  objetivos  anteriores  se  utilizará  exclusivamente  software  gratuito  que 
funciona bajo el sistema operativo GNU/Linux. Los cálculos mecanocuánticos se efectuarán con 
la aplicación GAMESS (versión R1 del 5 de diciembre de 2014), que permite resolver la ecuación 

ĤΨ(A,i) = EΨ(A,i)

Ψ(A,i) = Ψnuc (A)Ψel ,A (i)

Ĥel ,AΨel ,A (i) = Eel ,AΨel ,A (i) con Ĥel ,A = T̂el + V̂el + V̂nuc−el ,A

ĤnucΨnuc (A) = EΨnuc (A) con Ĥnuc = T̂nuc + Ûnuc  y U(A) = Eel ,A +Vnuc (A)
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de Schrödinger electrónica mediante diferentes métodos (Hartree-Fock ab initio o semiempíricos, 
interacción de configuraciones, Möller-Plesset, teoría del funcional de la densidad, etc.), así como 
calcular  diversas  propiedades  moleculares,  determinar  los  modos  normales  de  vibración, 
magnitudes termodinámicas, etc. Los datos que especifican el sistema a estudiar y el método de 
cálculo a utilizar deben ser suministrados a través de un fichero con extensión .inp (por ejemplo, 
nombre.inp). La aplicación GAMESS lee el fichero de datos, efectúa el cálculo correspondiente y 
crea un nuevo fichero con el mismo nombre y extensión .log (nombre.log) en el que guarda los 
resultados.

Esta aplicación y muchas otras de utilidad para estas prácticas y para la química en general 
están incluidas en la distribución QUBuntu del sistema operativo GNU/linux, basada, a su vez, en 
la  distribución ubuntu.  Las  instrucciones  para  instalarla  junto  con cierta  información general 
sobre la distribución se encuentran aquí. Al arrancar QUBuntu se abre una ventana del navegador 
con dicha información. En el menú Aplicaciones > QFIII y en la parte derecha de la barra inferior 
hay accesos directos a las aplicaciones que se utilizarán en estas prácticas; en particular: 
- Gedit  (icono de una libreta y un lápiz):  abre el editor de textos que se utilizará para ver y 
modificar ficheros de datos o de resultados.
- Terminal  (icono de un monitor): abre una terminal en modo texto (consola) para teclear y 
ejecutar instrucciones del sistema operativo (pulsando la tecla de retorno: ↩).
-  Calc  (icono  de  una  hoja  con  una  tabla):  abre  la  hoja  de  cálculo  del  paquete  ofimático 
LibreOffice (icono de una hoja con una tabla), que se utilizará para representar funciones.
- KCalc: abre una calculadora científica.
- Kalzium: abre una tabla periódica con información diversa sobre cada elemento.
- wxMacMolPlt (en el menú Aplicaciones > QFIII): abre una aplicación que permite visualizar 
gráficamente los resultados de los cálculos.
- Gabedit (en el menú Aplicaciones > QFIII): abre una aplicación que permite generar ficheros 
de  datos,  lanzar  cálculos  y  visualizar  gráficamente  los  resultados  de  una  gran  variedad  de 
programas de cálculo mecánico-cuántico. 
 Si clicas en el icono de la carpeta user se abrirá una ventana mostrando el contenido de la 
carpeta o directorio del usuario, en la cual hay otra carpeta –llamada QFIII– que contiene una 
copia de este guión y los ficheros de datos de cada práctica.

La aplicación GAMESS no dispone de icono, y se ha de ejecutar escribiendo en una terminal la 
instrucción rungms seguida de un espacio y el nombre del fichero que contiene los datos del 
cálculo a realizar, y pulsando la tecla de retorno. 

Importante:
Al apagar el sistema QUBuntu se pierden los ficheros generados durante la sesión, a no ser 

que  se  copien  en  un  pen  drive  (recordad  que,  antes  de  desenchufarlo,  hay  que  desmontarlo 
clicando con el botón derecho sobre su icono y seleccionando Expulsa) o se envíen a una cuenta 
de correo electrónico. Si se ha arrancado QUBuntu bajo VirtualBox también se pueden guardar 
los ficheros en una carpeta compartida con el  sistema anfitrión (por ejemplo, sf_Desktop)  o 
seleccionar Guardar el estado de la máquina al apagar para que se guarde el disco de trabajo.  

http://cvfitxers.ub.edu/docs/100784/QUBuntu/indexQUBuntu.html
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Práctica  1:  CURVA DE  ENERGÍA POTENCIAL DE  UNA MOLÉCULA 
DIATÓMICA Y ANÁLISIS DE SUS ORBITALES MOLECULARES. 

El objetivo de esta práctica es aprender lo esencial sobre el manejo del software que se 
utilizará  para  crear  o  modificar  ficheros  de  datos,  ejecutar  cálculos  y  visualizar  e  interpretar 
resultados. Los cálculos consistirán en resolver la ecuación de Schrödinger electrónica para una 
moléculas diatómica mediante el método Hartree-Fock restringido (RHF), buscar su distancia 
internuclear  de  equilibrio,  analizar  sus  orbitales  moleculares  y  determinar  su  energía  de 
disociación.  Con el  fin de mejorar  el  valor  obtenido para esta  energía se efectuarán también 
cálculos de tipo “interacción de configuraciones”.

1.1 Cálculo Hartree-Fock-Roothaan de la molécula HCl a geometría fija

a) Estructura de un fichero de datos1

Para facilitar la especificación de los datos de cada cálculo proporcionaremos los ficheros 
de datos ya confeccionados. Es importante que comprendas lo esencial de su contenido y seas 
capaz de introducir las modificaciones que se indican, lo cual te permitirá, cuando termines estas 
prácticas, crear tus propios ficheros de datos.

Haz doble clic sobre los iconos user, QFIII, practica1 y HCl.inp. Se abrirá este fichero 
con el editor gedit. Su contenido son las instrucciones para que la aplicación GAMESS resuelva la 
ecuación de Schrödinger electrónica para la molécula HCl mediante el método Hartree-Fock-
Roothaan (o RHF-LCAO) con una base mínima STO-3G a una distancia internuclear de 1,3 Å. 

Las dos primeras líneas (desde $CONTRL hasta $END) indican el tipo de cálculo a efectuar y 
algunas características de la molécula y de la forma en que se especificará su geometría:

• se utilizará el método RHF para calcular la función de onda electrónica (SCFtyp=RHF);
• se hará un único cálculo para la geometría especificada (RUNtyp=energy);
• las  coordenadas  de  los  núcleos  se  indicarán  mediante  coordenadas  internas,  es  decir, 

distancias  interatómicas,  ángulos  de  enlace,  ángulos  diedros  entre  distintos  enlaces,  etc. 
(Coord=Zmt;  la  geometría  especificada de  este  modo se  conoce como Z-matrix  en  el  argot 
químico-cuántico);

• la molécula es neutra (iCharg=0). 
En la cuarta línea ($SYSTEM ... $END) se indica la memoria RAM que debe reservarse 

para efectuar el cálculo (no lo modificaremos). 
En la siguiente ($BASIS ... $END) se especifica la base de orbitales atómicos (OAs) que 

se  desea  utilizar:  una  base  mínima de  tipo  STO-3G (GBasis=STO nGauss=3).  La  aplicación 
GAMESS tiene guardadas las especificaciones de los principales tipos de bases, de modo que 
basta indicarle la denominación del tipo de base escogida. 

A continuación ($GUESS ... $END) se indica como se escogerán los orbitales moleculares 
(OMs) de partida para iniciar el proceso iterativo autococonsistente (SCF). En todos los cálculos 

 Algunas palabras clave a las que se hará referencia más adelante se han destacado en rojo.1
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que  efectuaremos  se  partirá  de  unos  orbitales  obtenidos  mediante  el  método  semiempírico 
Extended-Hückel (Guess=Huckel).

Finalmente hay un bloque de líneas ($DATA ... $END) que contiene:
• una primera línea (Calculo ...) de texto informativo que no afecta al cálculo;
• una segunda línea (C1  0) con información sobre la simetría de la molécula (no detallaremos 
cómo se especifica esta información);
• la relación de núcleos que contiene la molécula junto con sus posiciones relativas expresadas en 
coordenadas internas:

Cl
H  1  1.3

La primera de estas dos líneas indica que hay un átomo de Cl y la segunda que hay otro de 
H a una distancia de 1,3 Å del Cl (que es el átomo 1). La línea en blanco siguiente indica que no 
hay más átomos.

b) Recuento de orbitales y electrones
Antes de efectuar tu primer cálculo Hartree-Fock escribe en tu libreta la relación de OAs de 

la base que va a utilizarse (χ1, χ2, … χm), el número de electrones de la molécula y el número de 

OMs  que  se  obtendrán  al  resolver  la  ecuación  de  Roothaan.  Teniendo  en  cuenta  que  la 
configuración  electrónica  de  la  molécula  es  de  capas  cerradas,  indica  cuantos  OMs  estarán 
ocupados y cuantos serán virtuales. 

c) Ejecución del cálculo Hartree-Fock. Fichero de resultados
Para  efectuar  el  cálculo  RHF  has  de  abrir  una  terminal  (icono  Terminal)  y  pasar  al 

subdirectorio QFIII/practica1 del directorio activo (/home/user):
cd QFIII/practica1

(¡recuerda que el sistema GNU/Linux distingue entre mayúsculas y minúsculas!). Si ejecutas la 
instrucción

ls -l
(l representa la letra ‘ele’ y no el número ‘uno’) aparecerá una lista con los dos ficheros de datos 
que utilizarás en esta práctica: HCl.inp y HCl_CI.inp.
Para efectuar el cálculo especificado en el fichero HCl.inp ejecuta la instrucción: 

rungms HCl.inp
El cálculo se completa en una fracción de segundo, generándose el fichero de resultados 
HCl.log. Ábrelo haciendo doble clic sobre su icono en la ventana de la carpeta practica1. 
Después de cierta información técnica(setenv…) verás un recuadro con información sobre la 
versión del programa, sus autores etc. Un poco más abajo verás una transcripción del fichero de 
datos, y poco después aparece la geometría especificada en dicho fichero expresada en 
coordenadas internas (YOUR FULLY SUBSTITUTED Z-MATRIX IS) y cartesianas (COORDINATES 
(BOHR)), así como la matriz de distancias internucleares expresadas en Angstroms. Las unidades 
de los resultados que se muestran en este fichero son, siempre que no se especifique otra cosa, 
atómicas. Dibuja en tu libreta un esquema que muestre cómo está orientada la molécula en 
relación con los ejes cartesianos. 
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Después hay información sobre la  base utilizada para el  cálculo (ATOMIC BASIS SET). 
Primero se describe la forma en que se construirá cada OA STO-3G a partir de orbitales de tipo 
gausiano  (GTOs),  descripción  que  no  detallaremos.  A continuación  aparece  una  relación  de 
propiedades  del  sistema a  estudiar.  Prescinde  del  TOTAL NUMBER OF BASIS SET SHELLS  y 
comprueba  que  los  valores  de  los  demás  parámetros  son  los  que  corresponden  al  sistema 
considerado:  el  número  de  funciones  de  base  (NUMBER OF CARTESIAN GAUSSIAN BASIS 
FUNCTIONS), el número de electrones (NUMBER OF ELECTRONS), la carga de la molécula (CHARGE 
OF MOLECULE), la multiplicidad del estado (SPIN MULTIPLICITY), el número de espinorbitales α 
y β ocupados (NUMBER OF OCCUPIED ORBITALS (ALPHA/BETA)), el número de átomos (TOTAL 
NUMBER OF ATOMS)  y  la  repulsión  internuclear  (NUCLEAR REPULSION ENERGY).  Calcula  este 
último dato con la calculadora y comprueba que coincide con el valor indicado en el fichero.

d) Proceso autoconsistente
Baja  la  barra  de  scroll  hasta  llegar  al  epígrafe  RHF SCF CALCULATION.  Bajo  éste  se 

encuentra la información sobre el proceso iterativo autoconsistente (SCF) de resolución de la 
ecuación de Roothaan (fci = εiSci, i= 1, …m), cuyas soluciones permitirán expresar cada OM 

Hartee-Fock como combinación lineal de los OAs de la base:

�  

La evolución del proceso iterativo se resume en la tabla que tiene por encabezamiento ITER 
…. Observa como va convergiendo la energía U (TOTAL ENERGY) hacia un valor mínimo. ¿Cuántas 
iteraciones ha requerido este cálculo HF-LCAO? 

e) Orbitales moleculares ocupados y virtuales
Un poco más abajo aparecen los coeficientes de los orbitales moleculares (EIGENVECTORS) 

agrupados  en  forma  de  matriz:  cada  columna  (ci)  contiene  los  coeficientes  c1i  …cmi  de  la 

combinación lineal que define un OM φi en función de los OAs χm; por ejemplo, los coeficientes 

de la primera columna permitirán expresar el primer OM en la forma: 
φ

1
 = c11 χ1

 + c21 χ2
 + … + cm1 χm

y así sucesivamente. El OA al que corresponde cada coeficiente se indica a la izquierda de la fila 
correspondiente:  número  de  orden  del  OA,  símbolo  del  átomo sobre  el  que  está  centrado  y 
numeración de éste, y tipo de OA designado mediante la notación S (l=0), X, Y, Z (l=1), XX, YY, 
ZZ, XY, XZ, YZ (l=2), etc. Por ejemplo, el OM φ

7
 será, redondeando sus coeficientes a una cifra 

decimal,
φ7 ≈ 0,1χ2s(Cl) – 0,2χ2pz(Cl) – 0,5χ3s(Cl) + 0,7χ3pz(Cl) + 0,5χ1s(H)

Encima de cada columna aparece la  energía  (εi)  del  OM correspondiente.  Teniendo en 

cuenta que los OMs aparecen en orden creciente de energías, identifica los OMs ocupados y los 
virtuales.

 
φi (
!r ) = csi

s=1

m

∑ χs (
!r )
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f) Orbitales σ y π
Tanto los OAs como los OMs de las moléculas lineales pueden clasificarse como σ, π, δ, … 

según correspondan a valores 0, 1, 2, … del número cuántico |m|. Se puede demostrar que los σ 
tienen simetría de revolución en torno al eje internuclear y que los π, si se escogen reales, son 
antisimétricos (es decir, cambian de signo) frente a una rotación de 180° en torno a dicho eje. 
Utiliza este criterio para clasificar cada OA de la base como σ o π (las coordenadas cartesianas de 
los  núcleos,  al  principio  del  fichero  de  resultados,  te  indicarán  cuál  es  el  eje  internuclear). 
Teniendo en cuenta que un OM σ (o uno π) ha de ser combinación lineal de OAs σ (o π), mira a 
qué OAs corresponden los coeficientes no nulos de cada OM y clasifícalo como σ o π. Numera 
las  subcapas  (conjuntos  de  OMs  degenerados)  formadas  por  OMs  σ  en  orden  creciente  de 
energías (1σ, 2σ, …) y haz lo mismo con las subcapas formadas por OMs π (1π, 2π, …). Utiliza 
esta notación para escribir la configuración electrónica del estado electrónico fundamental de la 
molécula (1σ2, 2σ2, etc.) y su determinante de Slater (utiliza la notación abreviada en la que sólo 
se indica la diagonal principal). Comprueba que la configuración electrónica es de capas cerradas.

g) Orbitales internos y de valencia
Clasifica cada OA de la base como interno o de valencia (recuerda que la capa de valencia 

es la última capa ocupada en la configuración electrónica del átomo). Clasifica también cada OM 
ocupado  como  interno  o  de  valencia  según  sean  internos  o  de  valencia  los  OAs  que  más 
contribuyen en la combinación lineal (mayor coeficiente en valor absoluto).  Observa que sus 
energías son más negativas cuanto más interno es el OM –debido a la mayor atracción electrón-
núcleos–, y que la clasificación interno/valencia no es estricta (por ejemplo, un OM de valencia 
puede tener  pequeñas contribuciones de OAs internos),  a  diferencia  de lo  que ocurre  con la 
clasificación “exacta” σ/π.

h) Desgloses de la energía U
Observa los desgloses de la energía U (TOTAL ENERGY) que aparecen a continuación, bajo 

el  epígrafe  ENERGY COMPONENTS:  la  energía  electrónica  aparece  primero  desglosada  en  un 
término monoelectrónico, que incluye la energía cinética de los electrones y la de atracción con 
los  núcleos,  y  otro  bielectrónico,  que  representa  la  repulsión  interelectrónica.  Después  se 
desglosan las distintas contribuciones a la energía potencial. Prescinde del dato VIRIAL RATIO.

A continuación aparece, bajo el epígrafe ENERGY ANALYSIS, un nuevo desglose en el que se 
utiliza  una  denominación  diferente  para  algunos  de  los  términos.  Comprueba  que  la  TOTAL 
ENERGY (U) es la suma de la ELECTRONIC ENERGY y la N-N REPULSION.

i) Análisis poblacional
A continuación  aparece  el  análisis  poblacional  (MULLIKEN AND LOWDIN POPULATION 

ANALYSES). El único resultado de este análisis que consideraremos es el reparto de la densidad 
electrónica total entre los átomos de la molécula que aparece bajo el epígrafe TOTAL MULLIKEN 
AND LOWDIN ATOMIC POPULATIONS. Este reparto conduce a unas “poblaciones” electrónicas para 
cada átomo (MULL.POP. y LOW.POP.), las cuales, multiplicadas por la carga del electrón (–1 u.a.) 
y sumándoles la carga del núcleo correspondiente (Z u.a.) producen las “cargas netas localizadas” 
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sobre cada átomo (CHARGE).  Estas cargas no son observables que podamos medir –aunque se 
utilizan mucho en discusiones cualitativas– y existen varios criterios para definirlas. Los más 
sencillos y populares son los de Mulliken y Löwdin, en los que las poblaciones se calculan a 
partir de los coeficientes de los OMs ocupados y de las integrales de solapamiento entre los OAs. 
Observa que las cargas netas localizadas sobre los átomos de H y Cl calculadas mediante uno y 
otro método son sensiblemente diferentes, aunque ambos métodos producen cargas del mismo 
signo  que  concuerdan  cualitativamente  con  las  expectativas  basadas  en  la  diferencia  de 
electronegatividades  de  los  átomos.  ¿Cual  cabe esperar  que sea  la  dirección preferida  en un 
ataque a la molécula por parte de un reactivo electrófilo? ¿Y si el atacante es nucleófilo?

j) Momento dipolar eléctrico
Casi al final del fichero de resultados aparecen, bajo el epígrafe ELECTROSTATIC MOMENTS, 

las componentes cartesianas (DX, DY, DZ) y el módulo (/D/) del momento dipolar eléctrico de 

la molécula (〈ΦHF|dxΦ
HF

 〉, etc.) para la distancia internuclear considerada expresados en debyes. 

Teniendo en cuenta la orientación de la molécula sobre los ejes cartesianos, comprueba que dicho 
momento es un vector dirigido desde el átomo con carga neta localizada negativa hacia el de 
carga neta positiva (convenio “físico”). Cierra el fichero de resultados.

1.2 Curva de energía potencial

Calcularemos  la  energía  potencial  U(R)  para  el  estado  electrónico  fundamental  de  la 
molécula  HCl  resolviendo la  ecuación de  Schrödinger  electrónica  mediante  el  método RHF-
LCAO con base mínima STO-3G para las distancias internucleares indicadas en la tabla adjunta.

Para  cambiar  la  distancia  tendrás  que  editar  el  fichero  HCl.inp,  modificar  el  dato 
correspondiente (utilizando un punto para separar los decimales), grabar el fichero modificado 
(botón Desa), ejecutar de nuevo la aplicación GAMESS (puedes recuperar la instrucción rungms 
HCl.inp con la tecla de mover el cursor hacia arriba). Tras finalizar el cálculo abre el fichero de 
resultados HCl.log (fíjate que los resultados del cálculo anterior no se ha perdido, están en un 

R/Å Eel/hartree Vnuc/hartree
0.7

0.8

1.0

1.3

1.6

2.0

3.0

4.0
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fichero con el mismo nombre al que se le ha añadido la fecha y hora en que se efectuó el cálculo). 
Construye  una  tabla  con  los  valores  de  la  distancia  R  en  Angstroms  y  las  energías  Eel 
(ELECTRONIC ENERGY) y Vnuc (NUCLEAR REPULSION ENERGY) con tres decimales como mínimo. 
Para evitar errores al copiar los datos lo más práctico es abrir la hoja de cálculo LibreOffice 
Calc  clicando  sobre  su  icono  (tarda  un  poco)  i  copiar  los  3  datos  anteriores  en  columnas 
contiguas  de  una  hoja.  Guarda  la  tabla  de  datos  (Save as…  del  menú  File)  en  la  carpeta 
practica1. Obtén los valores de la energía U correspondiente a cada distancia, sumando los de 
las columnas Eel y Vnuc. Representa gráficamente y por separado las energías Eel, Vnuc y U en 
función de R. Para ello selecciona la columna de R y la columna correspondiente a la energía que 
queráis representar (para seleccionar dos columnas no consecutivas hay que mantener la tecla 
CTRL apretada al clicar sobre la segunda). Selecciona la opción Chart… del menú Insert. En la 
ventana que aparece,  selecciona el  XY(Scatter)  y  clica  en  el  segundo dibujo  (Points and 
Lines), selecciona Line type Smooth y clica en Next>> (3 veces) y en Finish. 

¿A qué límites ha de tender la repulsión internuclear para R → 0 y para R → ∞? Observa 
que la energía electrónica de la molécula aumenta con la distancia internuclear. ¿Qué le ocurre a 
la molécula cuando R → ∞ y cuando R → 0? ¿A qué valores deberá tender la energía electrónica 
para R → ∞ y para R → 0? La curva de U(R) ha de presentar un mínimo a una distancia que se 
conoce como distancia internuclear de equilibrio (Re).

 

1.3 Distancia internuclear de equilibrio y energía de disociación 

Subdividiendo el intervalo de distancias que contiene a Re en intervalos más pequeños y 
recalculando los valores de U en cada nuevo punto podríamos ir acotando el valor de Re. Como 
este  procedimiento  es  poco  práctico  (sobre  todo  para  moléculas  con  más  de  dos  àtomos), 
utilizaremos  una  opción  de  GAMESS  que  permite  localizar  automáticamente  la  distancia 
internuclear de equilibrio a partir de un un valor aproximado indicado en el fichero de datos (este 
tipo de cálculo se conoce, en el argot químico-cuántico, como  “optimización de geometría”). 
Para utilizar esta opción basta substituir RUNtyp=energy  por RUNtyp=optimize  en la primera 
línea del fichero de datos HCl.inp; la optimización será más rápida si se pone como distancia 
internuclear de partida para el proceso de optimización el valor que corresponde a la energía U 
más baja de las recogidas en la tabla del apartado 1.2. Ejecuta la aplicación GAMESS con el fichero 
de datos modificado y abre el fichero HCl.log para ver los resultados.

a) Optimización de la geometría
Observa  que,  tras  un  listado  de  resultados  similar  al  que  se  obtiene  en  un  cálculo  a 

geometría fija (un cálculo “puntual”), se inicia (donde pone NSERCH=1) un nuevo cálculo HF con 
una geometría modificada automáticamente por la aplicación GAMESS en base a los gradientes de 
U obtenidos en el primero (que se identifica mediante NSERCH=0). El parámetro NSERCH es un 
contador de cálculos HF. Observa que la información presentada sobre el segundo cálculo es más 
breve que la del primero. Los cálculos HF se suceden hasta que se localiza el mínimo de la 
función U (EQUILIBRIUM GEOMETRY LOCATED), tras lo cual se indica la geometría, energía total y 
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OMs correspondientes al mínimo. ¿Cuántos cálculos HF han sido necesarios para encontrar la 
geometría de equilibrio?

Apunta  la  distancia  internuclear  de  equilibrio  (Re)  obtenida  y  compárala  con  el  valor 
experimental:  1,275  Å.  La  discrepancia  entre  ambos  valores  se  debe  a  las  aproximaciones 
implícitas en el método de cálculo y a que los valores experimentales suelen ser promedios sobre 
las vibraciones moleculares.¿Qué aproximaciones incluye el cálculo realizado?

b) Energía de disociación De

Tomando  U(4Å)  como  aproximación  de  U(∞)  (el  enlace  H-Cl  se  puede  considerar 
prácticamente roto a 4 Å), haz una estimación de la energía de disociación De = U(∞)–U(Re) y 
comprueba que se obtiene un valor (≈ 10,5 eV) mucho mayor que el experimental, que es de 4,62 
eV (1 hartree = 27,2114 eV). Esto se debe a que el error inherente al cálculo HF de capas cerradas 
aumenta mucho para grandes distancias internucleares: como cada OM ha de estar ocupado por 
dos electrones,  el  método RHF no puede describir  correctamente el  sistema formado por  un 
átomo de H –con un solo electrón 1s– y otro de Cl, que también tiene un electrón desapareado. 
En consecuencia, la energía electrónica calculada está muy por encima de la exacta para tales 
geometrías.

c) Método de interacción de configuraciones
El cálculo de la  energía de disociación mejora notablemente si  se  utiliza el  método de 

interacción de configuraciones (CI) en lugar del RHF. Una función de onda de tipo CI  es una 
combinación lineal de determinantes de Slater que incluye, además del determinante HF (ΦHF), 
otros (Φ1, Φ2, …) en los que se han substituido espinorbitales ocupados por virtuales:

ΨCI = C0 ΦHF + C1 Φ1 + C2 Φ2 + …
El fichero HCl_CI.inp contiene los datos para efectuar un cálculo puntual CI para una distancia 
internuclear de 4 Å incluyendo, además del determinante HF, los determinantes en los que uno o 
dos  electrones  del  último  orbital  ocupado  –el  HOMO– se  han  pasado  al  orbital  virtual  –el 
LUMO– (determinantes mono y disubstituidos). El bloque de datos $CIDRT iExcit=2 nFzC=6 
nDOc=3 nVal=1 $END incluye los parámetros necesarios para este tipo de cálculo; por ejemplo, 
iExcit=2 indica que se incluirán determinantes con, a lo sumo, 2 orbitales substituidos respecto 
del determinate HF, y nVal=1 indica que hay 1 orbital virtual. 

Ejecuta este cálculo y comprueba que, en el fichero de resultados, aparece la información 
sobre el cálculo HF seguida de la del cálculo CI (GUGA CI OPTIONS,  etc.). Baja hasta donde 
aparece la energía U obtenida con el método CI (STATE # 1 ENERGY = …) y comprueba que es 
inferior  a la resultante del cálculo HF (puedes verla en el mismo fichero, al final de proceso 
iterativo SCF). Justifícalo.

Inmediatamente  después  de  la  energía  CI  aparecen  los  coeficientes  optimizados  de  los 
distintos determinantes en la función de onda CI (C0, C1 y C2). Cada determinante se identifica 
mediante  los  números  de  ocupación  de  los  tres  OMs  ocupados  de  mayores  energías  del 
determinante HF y del LUMO: 2220 para el determinante HF (|… 2πxα 2πxβ 2πyα 2πyβ 5σα 

5σβ|), 2202 para el determinante en el que se ha substituido el HOMO (es decir, la pareja de 
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espinorbitales:  5σα  y  5σβ)  por  el  LUMO  (espinorbitales  6σ∗α  y  6σ∗β)  y  2211  para  el 
determinante en el que sólo se ha substituido uno de los espinorbitales 5σ (en realidad hay dos 
determinates  de  este  tipo:  |…  5σα  6σ∗β|  y  |…  5σβ  6σ∗α|).  Observa  que  el  determinante 
disubstituido 2202 tiene un peso (cuadrado de su coeficiente) similar al del determinante HF en la 
función CI, lo cual indica que un solo determinante describirá muy mal el estado electrónico para 
esta distancia internuclear:  ΨCI ≈ 0,7 |… 5σα 5σβ| – 0,7 |… 6σ∗β 6σ∗α| 

Optimiza la geometría con el método CI, partiendo de la distancia H-Cl obtenida mediante 
el método HF. Este tipo de cálculo requiere que la ejecución se efectúe en un solo core, para lo 
cual tienes que añadir un ‘1’ al final de la instrucción:

rungms HCl_CI.inp 1
Recalcula De “a nivel” CI y comprueba que se obtiene un valor (≈ 3,93 eV) notablemente mejor 
que  el  obtenido  a  nivel  HF.  Busca  los  coeficientes  de  los  determinantes  para  la  geometría 
optimizada (un poco antes de EQUILIBRIUM GEOMETRY LOCATED) y observa que el coeficiente del 

determinante  HF  en  la  función  CI  es  mucho  mayor  que  el  de  los  demás  determinante  (los 
determinantes monosubstituidos 2211 no aparecen porque tienen coeficientes muy pequeños). 
Esto indica que, para la geometría de equilibrio, el determinante HF proporciona, por sí solo, una 
buena descripción del estado electrónico:  ΨCI ≈ ΨHF = |… 5σα 5σβ|

¿Por qué disminuye De al pasar del método HF al CI?

d) Energía de disociación De con el método CI y una base extendida
Repite los cálculos del apartado c) tomando U(4Å) como aproximación de U(∞) y utilizando 

una base extendida de tipo split-valence (doble Z para los OAs de valencia y mínima para los 
internos), con funciones de polarización sobre el cloro (un conjunto de 6 funciones d centradas 
sobre  este  átomo)  y  sobre  el  hidrógeno (un  conjunto  de  3  funciones  p  centradas  sobre  este 
átomo).  En el  argot  químico-cuántico,  se  la  conoce como base  6-31G** o  6-31G(d,p).  Para 
utilizar esta base tendrás que cambiar esta línea del fichero de datos HCl_CI.inp:

$BASIS GBasis=STO nGauss=3 $END
por

$BASIS GBasis=N31 nGauss=6 ndFunc=1 npFunc=1 $END
(ten en cuenta que ha de haber un espacio en blanco antes del $).

En el bloque  $CIDRT … $END  has de cambiar el valor de nVal  (número de orbitales 
virtuales) por el que corresponda a la nueva base. Cambia también iExcit=2 por iExcit=4 , para 
que el número máximo de electrones que pasen de orbitales ocupados a virtuales al generar los 
determinantes de Slater sea 4 (determinantes “tetrasubstituidos”). Puedes hacerte una idea del 
número de determinantes de Slater que incluye ahora la función CI consultando el dato NUMBER 
OF CONFIGURATIONS del fichero de resultados. Deberías obtener una energía de disociación De ≈ 
4,41 eV, bastante más próxima al valor experimental. Si se hubiera tomado U(8Å) en lugar de 
U(4Å) como aproximación de U(∞) se habría obtenido un valor aún mejor: De ≈ 4,57 eV.

Anota  los  valores  que has  obtenido en este  apartado para  De  y  Re  (éste  con todos  los 
decimales), ya que los necesitarás en el apartado 3 e).  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Práctica 2: MOLÉCULAS POLIATÓMICAS

2.1  Geometría  de  equilibrio  de  la  molécula  H2O.  Análisis  de  sus  orbitales 
moleculares canónicos y localizados

a) Fichero de datos
El fichero H2O.inp contiene los datos necesarios para efectuar una optimización geométrica 

de  la  molécula  H2O  a  nivel  HF-LCAO  con  base  mínima  STO-3G.  Observa  como  se  ha 
especificado la geometría aproximada de partida:

O
H  1  1.0
H  1  1.0  2  105.0

El primer átomo es un O, el segundo un H a distancia 1,0 Å del primero (el 1) y el tercero un H a 
la misma distancia 1,0 Å del 1 y formando un ángulo 105,0° con el 1 y el 2 (ángulo 3-1-2).

b) Recuento de orbitales y electrones
Escribe  en  tu  libreta  la  relación  de  OAs de  la  base  que  va  a  utilizarse,  el  número  de 

electrones de la molécula y el número de OMs que se obtendrán, desglosándolos en ocupados y 
virtuales.

c) Optimización de la geometría
Abre una terminal, pasa al subdirectorio QFIII/practica2  y ejecuta GAMESS con los 

datos del fichero H2O.inp. Abre el fichero de resultados y comprueba que los valores que has 
anotado en la libreta son correctos. Para ver directamente los resultados del último cálculo HF 
puedes buscar  la  palabra LOCATED  utilizando el  submenú Cerca…  del  menú Cerca.  ¿Cuántos 
cálculos HF han sido necesarios para localizar la geometría de equilibrio? Mira la geometría 
resultante de la optimización (a continuación de THE CURRENT FULLY SUBSTITUTED Z-MATRIX 
IS) y compárala con la experimental: ROH = 0,957 Å, αHOH = 104,5°. Calcula el porcentaje de 
error  de los  valores  obtenidos.  Haz una representación esquemática de la  molécula sobre un 
sistema de ejes cartesianos a partir de las coordenadas cartesianas que se indican un poco más 
arriba, indicando la numeración de los átomos (1, 2 y 3). Comprueba que el momento dipolar de 
la  molécula  tiene  la  dirección  y  sentido  previsibles  y  compara  su  módulo  con  el  valor 
experimental (1,838 debyes). ¿Qué factores pueden influir en el error del valor calculado?

d) Orbitales σ y π
Los orbitales de una molécula plana pueden clasificarse como σ o π según sean simétricos 

o antisimétricos respecto de una reflexión sobre el plano molecular. Clasifica los OAs de la base 
y, teniendo en cuenta que los OMs σ/π han de ser combinaciones lineales de OAs σ/π, clasifica 
también los moleculares.
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e) Orbitales enlazantes y antienlazantes
Para  cada  OM de  la  geometría  optimizada  haz  una  representación  esquemática  de  las 

principales  contribuciones  de  los  OAs  a  cada  OM,  teniendo  en  cuenta  la  orientación  de  la 
molécula respecto de los ejes cartesianos. Por ejemplo, el tercer OM es:

φ3 = 0,61 χ2px(O) + 0,45 χ1s(H2) – 0,45 χ1s(H3)
y la representación esquemática de sus contribuciones atómicas es la indicada en la siguiente 
figura: 

En general, para representar cada orbital conviene dibujar primero los ejes cartesianos, XYZ, en 
perspectiva y representar en dichos ejes los átomos de la molécula junto con los enlaces. A  
continuación se dibujan de forma esquemática los orbitales atómicos cuyos coeficientes sean 
mayores que 0,1 en valor absoluto, teniendo especial cuidado en orientarlos correctamente 
respecto a los ejes. No obstante, en algunos casos se obtiene un esquema más claro mediante una 
representación plana en dos ejes cartesianos, como se ha hecho en la figura anterior. 
Clasifica los OMs como ocupados o virtuales, y los primeros como internos o de valencia. En el 
esquema del OM φ3 se aprecia que este orbital tiene contribuciones atómicas importantes y del 

mismo signo (“solapamiento positivo”) por parte de OAs de valencia de los átomos contiguos O 
y H2, por un lado, y de los átomos O y H3, por otro; decimos, por ello, que es enlazante entre el O 
y cada átomo H. Si un OM de valencia tiene contribuciones atómicas importantes y de distinto 
signo (“solapamiento negativo”) entre dos átomos contiguos decimos que es antienlazante, entre 
ellos, y si sólo tiene contribuciones importantes por parte de un átomo o de átomos no contiguos 
será no enlazante. Clasifica los OMs de valencia de acuerdo con este criterio (puede ocurrir que 
unos orbitales sean más enlazantes que otros, y que el carácter enlazante o no enlazante de alguno 
sea discutible). Observa la ordenación energética de los OMs: el más estable es el interno, luego 
vienen  los  de  valencia  enlazantes,  después  los  no  enlazantes  y,  finalmente,  los  virtuales 
antienlazantes.

f) Visualización de resultados
Clica sobre el icono de la aplicación wxMacMolPlt en el menú Applications/QFIII. Clica 

sobre el menú File y selecciona el submenú Open... En la ventana que aparece haz doble clic 
sobre QFIII, sobre practica2 y sobre el fichero de resultados H2O.log. Aparecerá un dibujo de 
la molécula que puede girarse clicando sobre ella y arrastrando el ratón. Puedes cambiar el tipo 
de representación con los submenús del menú View (Ball and Sticks en el submenú Display 
Style es el que queda mejor). Para cambiar el tamaño de la molécula hay que mover el ratón 
hacia arriba o hacia abajo mientras se mantiene pulsada la tecla Mayúscula.

O1

H2H3 y

x
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Puedes  ver  cómo  ha  ido  cambiando  la  geometría  de  la  molécula  a  lo  largo  de  la 
optimización usando la barra de scroll que hay abajo a la derecha de la ventana. 

Para  representar  uno  de  los  OMs  calculados  utiliza  el  menú  Subwindow,  el  submenú  
Surfaces, selecciona 3D Orbital. Aparecerá una ventana en la que se podrá elegir el conjunto 
de  orbitales  a  representar  (Select Orbital Set),  la  calidad  del  dibujo  (Number of Grid 
Points),  el  orbital  en  concreto  (Selct Orb:),  el  valor  de  la  superficie  a  dibujar  (Contour 
Value:) el tipo de superficie (marcad la opción Wire Frame o bien Solid y Smooth, en este 
último caso poned también un 30 en Transparency para que se siga viendo la molécula). Por 
último clica en Update  y se efectuará el  cálculo del dibujo (aunque la expresión del OM se 
determinó al ejecutar la aplicación GAMESS ahora se necesita calcular el valor del orbital sobre una 
malla de puntos para poder dibujarlo). Para borrar el orbital representado clica en Suprimeix. 
Representa cada OM y comprueba que la forma de éstos se corresponde con los esquemas que 
has dibujado en la cuestión anterior.

g) Orbitales localizados
Un  determinante  no  cambia  si  substituimos  sus  filas  (o  columnas)  por  combinaciones 

lineales ortonormales de ellas. De acuerdo con esto, podemos substituir los OMs ocupados en un 
determinante de Slater por combinaciones lineales ortonormales de ellos sin que cambie el valor 
del determinante, es decir,  sin que cambie la función de onda total del sistema. Esto permite 
substituir los OMs ocupados que se obtienen en un cálculo HF (los OMs canónicos) por OMs 
localizados, que se calculan transformando los canónicos mediante algún criterio de localización; 
por  ejemplo,  que las  distancia  media  entre  parejas  de  electrones  sea  mínima para  electrones 
descritos  por  un mismo orbital  y  máxima para  electrones  de orbitales  diferentes  (criterio  de 
Boys).  Los  orbitales  resultantes  se  encuentran  casi  siempre  localizados  en  las  zonas  de  la 
molécula en las que el modelo de Lewis ubicaría los enlaces y los pares no enlazantes, lo cual 
proporciona un soporte teórico a este modelo empírico.

La inclusión del  dato Local=Boys  en el  fichero H2O.inp  hace que GAMESS utilice el 
criterio de Boys para localizar los orbitales canónicos ocupados obtenidos mediante un cálculo 
HF.  Para  representarlos  con  la  aplicación  wxMacMolPlt  elige  Localized Orbitals  en  el 
apartado de Select Orbital Set: de la ventana de Surfaces y sigue el mismo procedimiento 
que utilizaste para representar los orbitales canónicos. ¿A qué par de Lewis corresponde cada 
orbital localizado? A partir de las representaciones obtenidas con la aplicación wxMacMolPlt para 
los dos OMs canónicos φ2  y φ3  comprueba que la forma de los OMs localizados 2º  y 3º  se 
corresponde aproximadamente con la suma (λ2 ≈ φ2+φ3) y la diferencia (λ3 ≈ φ2–φ3) de aquellos. 

Comprueba  también  que  los  OMs  localizados  4  y  5  son,  aproximadamente,  la  suma  y  la 
diferencia de los dos OMs canónicos φ4 y φ5.

Para representar la densidad electrónica total –que es la suma de los cuadrados de los OMs 
ocupados (canónicos o localizados)– clica sobre el botón Add… y selecciona 3D Total Electron 
Density. Haz que la superficie de densidad constante representada sea transparente para poder 
ver  el  esqueleto  de  la  molécula.  La  densidad  electrónica  total  puede  determinarse 
experimentalmente, a diferencia de lo que ocurre con las densidades asociadas a cada OM por 
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separado. Los OMs canónicos y los localizados proporcionan distintas particiones de la densidad 
electrónica total.

h) Optimización con una base extendida
Repite la optimización geométrica del H2O con la base 6-31G(d,p) que ya has utilizado en 

el apartado 1.3 d) de la práctica 1. Para utilizar esta base tendrás que cambiar la línea $BASIS… 
del fichero de datos H2O.inp de la manera indicada en aquel apartado. También puedes cambiar 
la geometría inicial por otra en la que las dos distancias O–H no sean iguales, para comprobar 
que el  proceso de optimización conduce a una geometría simétrica independientemente de la 
geometría de partida. 

Calcula los porcentajes de error de los nuevos valores obtenidos para la distancia OH y el 
ángulo  HOH  y  compáralos  con  los  correspondientes  a  los  cálculos  efectuados  con  la  base 
mínima. ¿Por qué desciende la energía electrónica al aumentar la dimensión de la base?
Observación: cuando hay muchos orbitales virtuales, la aplicación GAMESS sólo muestra, para la 
geometría optimizada, un número de OMs virtuales igual al doble del número de ocupados.

2.2 Barreras de rotación interna

El  objetivo  de  este  apartado  es  resolver  la  ecuación  de  Schrödinger  electrónica  de  la 
molécula de etano para distintas geometrías que representen sucesivos estadios de la rotación de 
uno de los grupos metilo respecto del otro, con el fin de evaluar la barrera energética que debe 
superarse para efectuar dicha rotación interna.

Calcularemos la energía potencial U (a nivel RHF-LCAO con base STO-3G) para distintos 
ángulos de rotación interna optimizando, para cada ángulo, el resto de las coordenadas nucleares. 
El fichero C2H6.inp del subdirectorio practica2 contiene los datos para efectuar cada cálculo, a 
falta únicamente de sustituir el doble interrogante ??  por el valor del ángulo de rotación. La 
especificación de la molécula y de su geometría inicial se efectúa del siguiente modo (la primera 
fila  y  la  primera  columna  de  la  tabla  se  han  incluido  para  facilitar  la  explicación,  pero  no 
aparecen en el fichero):

I    S   A      r      B       a        C      d
1  C
2  C  1  1.5
3  H  1  1.0  2  100.0
4  H  1  1.0  2  100.0  3  120.0
5  H  1  1.0  2  100.0  4  120.0
6  H  2  1.0  1  100.0  3   ??
7  H  2  1.0  1  100.0  6  120.0
8  H  2  1.0  1  100.0  7  120.0

Figura 1 Figura 2 

I

C

B
A

d(IABC)

H7

H6 H8

H3

H5 H4
C1

C2
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 El primer átomo es un C y el segundo el otro C, separado una distancia de 1,5 Å del primero: 
R(IA) = R(21) = 1,5Å. El tercero es un H situado a 1,0 Å del primero (R(IA) = R(31) = 1,0Å) y 
formando un ángulo de 100° con éste y el segundo (a(IAB) = R(312) = 100,0º). Los ángulos 
a(IAB)  se  toman siempre positivos y  ≤180º.   A partir  del  cuarto  átomo la  especificación se 
efectúa del modo siguiente:

especificación del átomo I:       S  A R(IA)  B a(IAB)  C d(IABC)
donde S es el símbolo químico del I-ésimo átomo, R(IA) es la distancia entre los núcleos I y A, 
a(IAB) es el ángulo formado por los núcleos I, A y B, y d(IABC) es el ángulo diedro formado por 
los planos IAB  y ABC,  con el sentido positivo indicado en la figura 1 mediante el sistema de 
proyección de Newman. Por ejemplo, el cuarto átomo es un H situado a una distancia R(IA) = 
R(41) de 1,0 Å del primero (que es un C); el ángulo del enlace a(IAB) = a(412) (HCC) es de 
100,0° y el diedro d(IABC) = d(4123) (HCCH) es de 120,0°. Para especificar la posición de un 
átomo I sólo se puede hacer referencia a átomos A, B y C que estén por encima del I en la lista.

a) Recuento de orbitales y electrones
Escribe  en  tu  libreta  la  relación  de  OAs de  la  base  que  va  a  utilizarse,  el  número  de 

electrones de la molécula y el número de OMs que se obtendrán, desglosándolos en ocupados y 
virtuales. 

b) Optimización restringida
Substituye el doble interrogante del fichero C2H6.inp (ángulo diedro 6-2-1-3) por 60.0 y 

efectúa el cálculo correspondiente (cambia de directorio en la terminal antes de ejecutarlo: cd .. 
y cd practica2). Observa que en el fichero de datos se ha especificado, en la segunda línea, 
nzVar=18 (el número de coordenadas internas) y se ha añadido una última línea:

$STATPT iFreez(1)=12 $END
para que se mantenga fija (se “congele”) la 12a coordenada interna –el ángulo diedro 6-2-1-3– 
durante la optimización geométrica (optimización “restringida”). Las demás coordenadas internas 
se optimizan independientemente.

Abre el fichero de resultados C2H6.log y comprueba que los valores anotados en tu libreta 
(apartado a) son correctos. Abre el fichero de resultados con el  programa wxMacMolPlt  para 
visualizar  la  geometría  de  la  molécula.  Conviene  mostrar  la  numeración  de  los  átomos 
seleccionando  con  el  menú  View  el  submenú  Atom  Labels.  La  geometría  considerada 
corresponde a una conformación alternada del etano (figura 2).

¿Cuántas variables independientes se habrán optimizado? Anota con cuatro decimales los 
valores de U y Vnuc para la geometría optimizada, así como la distancia C-C (con tres decimales) 

y el  ángulo H-C-C (con un decimal) correspondiente al  H cuyo diedro ha sido fijado (busca 
LOCATED y consulta, un poco más abajo, la tabla THE CURRENT FULLY SUBSTITUTED Z-MATRIX).

c) Curvas de energía
Repite la optimización restringida para los siguientes valores del ángulo de rotación interna: 

45°, 30° , 15° y 0° (conformación eclipsada), anotando en cada caso los valores obtenidos para U 
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y Vnuc, la distancia C–C y el ángulo H-C-C. Interpreta las pequeñas variaciones que se producen 

en estos dos parámetros al  pasar de la conformación alternada a la eclipsada. Representa las 
energías  U,  Vnuc  y  Eel  en  función del  ángulo de  rotación interna.  ¿Cómo serían las  curvas 

completas (ángulo diedro desde 0 hasta 360°)?. Observa que la repulsión internuclear es mínima 
para la conformación eclipsada, lo cual, a primera vista, puede resultar chocante (es la de mayor 
impedimento estérico). Interpreta este hecho teniendo en cuenta las variaciones que experimentan 
la distancia C-C y el ángulo H-C-C, antes anotados. Indica si el impedimento estérico que origina 
la barrera es un efecto debido fundamentalmente a la repulsión interelectrónica o a la repulsión 
internuclear. Calcula la diferencia entre los valores de U  para las conformaciones eclipsada y 
alternada y compárala con el valor experimental de la barrera rotacional: 2,93 kcal/mol (1 hartree 
equivale a 627,51 kcal/mol). Deberías obtener un resultado de unas 2,9 kcal/mol (la coincidencia 
con el  valor  experimental  es  sorprendentemente buena,  dado el  método de cálculo y la  base 
utilizados, por lo que cabe sospechar que se haya producido cierta compensación de errores).

d) Barrera rotacional del 1,2-difluoroetano
Modifica el fichero C2H6.inp para calcular la variación de U con la rotación interna del 

1,2-difluoroetano. ¿Qué intervalo de ángulos diedros tendrás que recorrer para determinar las 
barreras de rotación interna de esta molécula? Efectúa los cálculos necesarios para obtener la 
curva de U en función del ángulo de rotación interna (basta que aumentes este parámetro de 30° 
en 30°). Observa que la conformación más estable no es la que tiene los F en posiciones opuestas 
(anti), como cabría esperar en base al mayor volumen de estos átomos en comparación con el de 
los hidrógenos, sino la que los tiene en posiciones vecinas (gauche). Este “efecto gauche” se 
produce en moléculas con grupos X–C–C–Y en los que X e Y son muy electronegativos (F, OH, 
etc.). 

2.3 Optimización de la geometría de una conformación del CH3NH2

Construye  la  Z-matrix  para  la  molécula  CH3NH2  (metilamina)  correspondiente  a  una 
conformación en la que uno de los planos H-C-N bisecta el ángulo H-N-H. A partir de uno de los 
ficheros de datos de los apartados anteriores (el que creas conveniente), genera un nuevo fichero 
de datos para optimizar la geometría de esta molécula mediante el método RHF con base mínima 
STO-3G. Como distancias de enlace iniciales puedes utilizar los valores aproximados RCH = RNH 

= 1,0 Å y RCN = 1,4 Å. Para los ángulos haz estimaciones razonables. Optimiza la geometría de la 
conformación y compara los parámetros geométricos resultantes con las estimaciones de las que 
has partido.

2.4 Barrera de inversión del NH3 (ejercicio adicional optativo) 

Crea un fichero de datos con nombre NH3.inp para calcular la barrera de energía potencial U 
asociada al movimiento de inversión del amoníaco. Para especificar la geometría inicial de la 
molécula  de  una  manera  que  permita  modificarla  fácilmente  para  seguir  el  movimiento  de 
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inversión, conviene incluir en la lista de átomos –la Z-matrix– un primer “átomo” con símbolo X 
que el  programa no considerará como un átomo real,  sino como un punto de referencia –un 
dummy–  para  definir  la  geometría  molecular.  A partir  de  la  información  de  la  Z-matrix  el 
programa calcula las coordenadas cartesianas de cada núcleo y se prescinde del dummy para el 
resto de los cálculos. Para que el fichero de datos sea más sencillo fija en 1.0 Å la distancia N-H y 
no  optimices  la  geometría  en  cada  punto  de  la  curva.  Representa  la  energía  U  frente  a  la 
coordenada de inversión que hayas elegido y calcula la altura de la barrera de energía potencial. 
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Práctica 3: MODOS NORMALES DE VIBRACIÓN

En las prácticas anteriores hemos resuelto la ecuación de Schrödinger electrónica de una 
molécula y analizado la información que puede extraerse de sus soluciones.  En esta práctica 
calcularemos la matriz de derivadas segundas (hessiana) de la superficie de energía potencial de 
la molécula en su geometría de equilibrio y la diagonalizaremos para obtener los modos normales 
de vibración y sus frecuencias, información necesaria para el estudio del movimiento nuclear y 
los espectros vibracionales, y para el cálculo de propiedades termodinámicas.

A temperaturas  moderadas,  los  N  núcleos  de  una  molécula  “rígida”  (una  molécula  sin 
barreras  conformacionales  de  baja  energía)  efectúan  movimientos  vibracionales  de  pequeña 
amplitud en torno a sus posiciones de equilibrio, además de los movimientos de traslación y 
rotación.  De  acuerdo  con  la  mecánica  clásica,  dichos  movimientos  vibracionales  pueden 
descomponerse en 3N–6 (3N–5 si la geometrías de equilibrio es lineal) movimientos sencillos que 
se conocen como modos normales de vibración. En cada uno de éstos (por ejemplo, el modo 
normal i) todos los núcleos oscilan sinusoidalmente con la misma frecuencia (νi) y la misma fase 

(pasan por sus posiciones de equilibrio al mismo tiempo). Para determinar la dirección y amplitud 
de las oscilaciones de los núcleos en cada modo normal, así como la frecuencia de las mismas, 

debe calcularse la matriz hessiana U ( � ) de la energía U expresada en función de 

las  coordenadas  de  desplazamiento  cartesianas  ponderadas:  � ,  …  , 

. Si llamamos L a la matriz que diagonaliza la matriz U (Lt U L = ),  

cada columna de L  (cada vector  propio de U)  determina un modo normal;  por  ejemplo,  los 
elementos de la columna i (L1i, … L3N i ) determinan las amplitudes relativas de la oscilación de 

las coordenadas q1, … , q3N en el modo normal i, lo cual permite obtener inmediatamente los 

desplazamientos máximos relativos de cada coordenada nuclear en dicho modo normal :2

desplazamiento del núcleo 1: � , � , � ,

desplazamiento del núcleo 2: � , � , � ,  etc. 

Cada elemento diagonal � de la matriz �  (cada valor propio de U) determina la frecuencia de 

un modo normal: �

a) Modos normales del H2O (método HF)
El  fichero  H2O_HF.inp  contiene  los  datos  para  determinar  los  modos  normales  de  la 

molécula H2O a nivel Hartree-Fock con la base utilizada en el apartado h) de la práctica 2.1: 

Ukl =
∂2U

∂qk ∂ql

⎛
⎝⎜

⎞
⎠⎟ e

q1 = X1 − X1e( ) m1

q3N = ZN − ZNe( ) mN Λ

X1 − X1e =
L1i
m1

Y1 −Y1e =
L2i
m1

Z1 − Z1e =
L3i
m1

X2 − X2e =
L4 i
m2

Y2 −Y2e =
L5i
m2

Z2 − Z2e =
L6i
m2

λi Λ

ν i =
1
2π

λi

 En las expresiones siguientes se ha omitido una constante multiplicativa con unidades de LM1/2 que determina la 2

amplitud de las oscilaciones, a la cual se ha asignado el valor 1.
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6-31G(d,p).  La  geometría  especificada  en  el  fichero  ha  sido  previamente  optimizada  con  el 
mismo método de cálculo,  para asegurar  que corresponde a un mínimo de la  función U.  La 
opción  RUNtyp=hessian  (primera  línea  del  fichero)  indica  a  GAMESS  que  ha  de  calcular  la 
hessianana de U y diagonalizarla. Ejecuta la aplicación GAMESS con esos datos. En el fichero de 
resultados  H2O_HF.log  busca,  después  de  la  información  sobre  el  cálculo  HF,  la  relativa  al 
cálculo  de  la  matriz  hessiana  (CARTESIAN FORCE CONSTANT MATRIX)  y  su  diagonalización 
(NORMAL COORDINATE ANALYSIS IN THE HARMONIC APPROXIMATION).  Los  elementos  de  la 

matriz L divididos por la raíz de la masa del núcleo correspondiente ( � , etc.) aparecen un 

poco más abajo (los bloques de datos que se inician con las etiquetas TRANS. SAYVETZ y ROT. 
SAYVETZ no corresponden a aquella matriz). En el encabezamiento de cada columna aparece la 
frecuencia  del  modo  normal  (expresada  como  número  de  ondas  en  cm–1)  y  el  factor  de 
probabilidad que determina la intensidad de la banda correspondiente en el espectro IR de la 
molécula. Los modos normales que corresponden a traslaciones y rotaciones de la molécula sin 
deformarla son los seis primeros, y deberían tener frecuencias nulas, aunque la imprecisión de los 
cálculos  puede  hacer  que  aparezcan  con  números  de  ondas  de  decenas  de  cm–1  (o  incluso 
mayores).  Los  3N–6  modos  restantes  son  los  de  vibración,  que  tienen  números  de  ondas 
claramente positivos e implican deformación de la molécula.

Dibuja la molécula sobre unos ejes cartesianos indicando la numeración de cada átomo y 
representa  aquellos  modos  normales  mediante  vectores  que  partan  de  cada  núcleo  con 
componentes iguales a las coordenadas de desplazamiento cartesianas obtenidas a partir de los 

coeficientes de la matriz L (� , etc.) redondeadas a dos cifras decimales. Ten en 

cuenta  que  las  flechas  indican  la  dirección  inicial  del  movimiento.  En general, para que la 
representación quede con la suficiente claridad es importante seguir los siguientes pasos:  dibujar 
los ejes cartesianos, XYZ, en perspectiva;  representar en dichos ejes los átomos de la molécula y 
los enlaces;  dibujar los vectores de desplazamiento  teniendo especial cuidado en dibujar 
correctamente su orientación respecto a los ejes y en que sus módulos mantengan 
aproximadamente sus proporciones relativas.

Para comprobar que las representaciones que has efectuado son correctas, abre el fichero de 
resultados  con  el  programa  wxMacMolPlt  y  selecciona  en  el  menú  Subwindow  la  opción 
Frequencies. Selecciona y visualiza un modo normal de vibración clicando sobre una de los 3 
últimos números de ondas. Para visualizar el modo normal, selecciona la opción Animate Mode 
del  menú  View  de  la  ventana  principal.  La  amplitud  de  las  oscilaciones  se  representa  muy 
aumentada para que se aprecie bien el tipo de movimiento. Visualiza los demás modos (ten en 
cuenta que la animación está pensada para las vibraciones, y las oscilaciones que se muestran 
para los modos traslacionales y rotacionales son ficticias). En el caso de las traslaciones existe un 
error en la representación que hace que el desplazamiento del O aparezca mayor que los de los 
Hs, cuando deberían ser todos iguales. 

Teniendo en cuenta que el momento dipolar de la molécula puede considerarse como una 
resultante de momentos dipolares de enlace, expresables a su vez como productos de cargas 
atómicas por distancias de enlace, indica si es previsible que varíe el momento dipolar de la 

L1i / m1

X1 − X1e = L1i / m1
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molécula en cada modo normal de vibración. ¿Cabe esperar que estos modos sean activos en el 
infrarrojo? 

b) Modos normales del H2O (método MP2)
Compara los números de ondas vibracionales calculados en la cuestión anterior con los 

valores experimentales: 1648,5 cm–1 (flexión), 3832,2 cm–1 (tensión simétrica) y 3942,5 cm–1 
(tensión  asimétrica).  Observarás  discrepancias  del  orden  de  centenares  de  cm–1,  debidas 
esencialmente a las aproximaciones inherentes al método HF, a la incompletitud de la base, a 
imprecisiones  en  la  optimización  de  la  geometría  y  a  desviaciones  respecto  del  modelo  de 
oscilador utilizado para obtener los valores experimentales. Los errores en la geometría y en la 
hessiana se pueden minimizar dando valores más pequeños a los parámetros que determinan la 
convergencia numérica. El error inherente al método HF se puede corregir parcialmente mediante 
un método de tipo perturbacional conocido como Möller-Plesset (MP). Se basa en que la función 

de onda HF es propia de la suma de operadores de Fock, que designaremos � :

�  

donde � es la suma del operador energía cinética de un electrón y el de atracción con los 
núcleos y � es el operador que representa, aproximadamente, la repulsión promedio entre un 
electrón y los demás en el método HF; � es el vector de posición del electrón i y � representa sus 

coordenadas  de  posición  y  de  espín.  Si  tomamos  � como  hamiltoniano  electrónico  no 
perturbado  y,  como  perturbación,  la  diferencia  entre  el  operador  de  repulsión  exacto  y  el 

aproximado que contiene el operador � :

�

podremos utilizar el método perturbacional para calcular correcciones a la energía y/o la función 
de onda HF. 

Para calcular con GAMESS la corrección de segundo orden a la energía (cálculo MP2) se ha de 
incluir la opción MPlevl=2 en el primera bloque del fichero de datos (entre $CONTRL y $END). El 
fichero  H2O_MP2.inp  incluye  los  datos  para  llevar  a  cabo  la  optimización  de  la  geometría 
(RUNtyp=Optimize) y el cálculo de los modos normales mediante el método MP2 (la opción 
HssEnd=.T. en la línea que empieza por $STATPT hace que se calculen los modos normales y las 
propiedades termodinámicas una vez optimizada la geometría). Ejecuta GAMESS con estos datos. 
En el fichero de resultados aparece, un poco antes del mensaje EQUILBRIUM GEOMETRY LOCATED, 
un desglose de la energía MP2 como suma de la energía HF y la corrección perturbativa de 
segundo orden (la de primer orden está incluida en la energía HF) ¿Que estimación de la energía 
de correlación proporciona el método MP2 para la geometría de equilibrio?

Observa que, una vez finalizada la optimización de la geometría se efectúan nuevos cálculos 
HF+MP2; esto es debido a que el cálculo de las derivadas segundas de U se efectúa de forma 
numérica.  Después  de  estos  cálculos,  hacia  el  final  del  fichero,  están  los  modos  normales. 

Ĥ HF

 
Ĥ HFΦHF = ε i

i=1

n
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Comprueba que los errores en los los números de ondas vibracionales han pasado a ser del orden 
de las decenas de cm–1, un orden de magnitud menores que con el método HF.

c) Modos normales del H2O (método DFT)
Otro método sencillo que incluye parte de la correlación electrónica se basa en la teoría del 

funcional  de  la  densidad  (DFT)  que  se  fundamenta  en  dos  teoremas,  enunciados  por  P. 
Hohenberg y W. Khon en 1964: el hamiltoniano de un sistema polielectrónico está determinado 
por  la  densidad monoelectrónica  de  su  estado fundamental  y  la  energía  de  éste  cumple  una 
condición de  mínimo respecto  de  densidades  monoelectrónicas  de  “prueba”,  similar  a  la  del 
teorema variacional respecto de funciones de onda de prueba. A partir de estos teoremas, Khon y 
Sham establecieron unas ecuaciones análogas a las del método HF en las que el potencial efectivo           
se  substituye  por  un  potencial  que  incluye,  además  de  la  repulsión  electrónica,  efectos  de 
correlación electrónica. Los resultados presentan el mismo aspecto que los de los cálculos HF. El 
potencial efectivo no se conoce de manera exacta, y dependiendo de la aproximación elegida 
diremos que hemos utilizado un “funcional” u otro. En esta práctica usaremos el conocido como 
B3LYP. 

Para hacer un cálculo DFT-KS-B3LYP basta cambiar en el fichero H2O_MP2.inp la opción 
MPlevl=2  por DFTtyp=B3LYP, añadir la linea $FORCE  METHOD=SEMINUM  $END  y guardar el 
fichero modificado con el nombre H2O_DFT.inp. Ejecuta GAMESS  con estos datos y comprueba 
que los errores en los números de ondas resultantes son del orden de las decenas de cm–1. 

 d) Modos normales del CO2 (método HF)
El fichero CO2_HF.inp contiene los datos necesarios para calcular los modos normales del 

CO2 a nivel HF/6-31G(d) (la misma base que has utilizado para el H2O, pero sin p’s, ya que no 
hay  hidrógenos),  con  la  geometría  optimizada  a  este  mismo  nivel.  Observa  que  ésta  se  ha 
especificado en coordenadas cartesianas (Coord=prinAxis). Ejecuta GAMESS con estos datos y 
comprueba que hay 3N–5 modos normales de vibración de los cuales dos están degenerados entre 
sí. Haz un esquema de cada modo normal de vibración y compáralo con las representaciones 
obtenidas mediante el programa wxMacMolPlt. Compara los números de ondas obtenidos con las 
experimentales:  673,2 cm–1 (flexión),  1354,0 cm–1 (tensión simétrica)  y 2396,3 cm–1 (tensión 
asimétrica). ¿Cuáles de estos modos serán activos en el infrarrojo?

e) Energía de disociación D0 del HCl
Como complemento del apartado 1.3 d) calcula la energía de disociación D0 ≈ De–hνe/2 de la 

molécula HCl mediante el método CI/6-31G(d,p) a partir del valor que obtuviste para De. Para 
calcular  la  frecuencia  vibracional  de  la  molécula  has  de  hacer  un  cálculo  de  la  hessiana 
(RUNtyp=Hessian)  para  la  distancia  internuclear  de  equilibrio  obtenida  en  aquel  apartado. 
Recuerda que los cálculos CI se han de ejecutar con un solo core (rungms HCl_CI.inp 1). Ten 
en cuenta que este cálculo es relativamente costoso y requerirá más tiempo que los anteriores. 
Deberías obtener un valor de D0 ≈ 4,38 eV.  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Práctica 4: CAMINO DE REACCIÓN. ESTADO DE TRANSICIÓN

El objetivo de esta práctica es resolver la ecuación de Schrödinger electrónica para distintos 
estadios de una reacción química entre dos moléculas, con el fin de obtener el perfil energético de 
la reacción y evaluar la barrera energética que deben superar los reactivos para que se produzca la 
reacción directa y los productos para la inversa. También calcularemos la constante de equilibrio 
termodinámica y la constante de velocidad de cada semirreacción usando las ecuaciones que nos 
proporciona la termodinámica estadística.

Para estudiar una reacción química bajo la aproximación de Born-Oppenheimer deberemos 
empezar por calcular la zona pertinente de la “superficie” de energía potencial U  que rige el 
movimiento de todos los núcleos de las especies reaccionantes: la “supermolécula”. Esto exige 
resolver  la  ecuación  de  Schrödinger  electrónica  para  diferentes  geometrías  de  dicha 
supermolécula. Los reactivos corresponderán a geometrías de ésta en las que la distancia entre las 
moléculas  reaccionantes  sea  elevada  y  los  productos  a  geometrías  en  las  que  las  especies 
producidas en la reacción estén muy separadas. Llamamos coordenada de reacción a la sucesión 
de geometrías de mínima energía potencial (U) que conecta reactivos y productos. Si la reacción 
transcurre en una sola etapa elemental, la función U tendrá un único máximo sobre la coordenada 
de reacción,  que corresponderá a un “punto de silla” de la hipersuperficie U  conocido como 
estado de transición. 

En  general  no  podemos  visualizar  la  función  U  debido  a  que  depende  de  3N–6 
coordenadas, siendo N el número de átomos de la 
supermolécula. En la figura 3 se ha representado el 
perfil  energético  de  la  reacción,  que  es  la 
representación de U a lo largo de la coordenada de 
reacción. La diferencia entre los valores que toma 
U  en  las  zonas  de  reactivos  y  de  productos 
proporciona  información  sobre  la  termodinámica 
del proceso y la altura de la barrera energética que 
separa el estado de transición de aquellas zonas nos 
informa sobre la cinética de las reacciones directa e 
inversa. Para una reacción del tipo

 X + YZ ––> XY + Z
podemos representar  la  superficie  U  si  fijamos la 
dirección de acercamiento del átomo X a la molécula YZ, lo cual deja 3N–6–1 = 2 coordenadas 
nucleares independientes (figura 4).

En esta práctica obtendrás el perfil energético de una reacción SN2 (substitución nucleófila 
de orden 2):

NC– + CH3F ––> NCCH3 + F–

en fase gaseosa. Para ello, efectuarás varios cálculos RHF-MP2-LCAO con la base 6-31+G(d), de 
tipo doble Z de valencia con funciones de polarización d (sin funciones de polarización en los 

 U

Coordenada de reacción

reactivos
X + YZ

productos
XY + Z

complejo
X…YZ complejo

XY…Z

estado de transición
[X…Y…Z]

Figura 3



!  26

hidrógenos)  y  difusas  (+)  para  la  supermolécula 3

(NCCH3F)– a diferentes geometrías: partiendo de una 
próxima a la de equilibrio de las moléculas CH3F y 
NC– con una distancia grande entre ambas (valle de 
reactivos),  irás  disminuyendo  esta  distancia  en 
cálculos  sucesivos  hasta  alcanzar  una  geometría 
próxima  a  la  de  equilibrio  de  la  molécula  NCCH3. 
Para  cada  valor  de  aquella  distancia  deberán 
optimizarse  las  demás  coordenadas  internas  de  la 
supermolécula. Este tipo de cálculos tardarán más que 
los  que  habéis  hecho  hasta  el  momento,  debido  al 
mayor tamaño del sistema, a la utilización del método 
MP2, al tamaño de la base, y al cálculo de magnitudes 
termodinámicas  que  requiere  obtener  los  modos 
normales de vibración.

a) Entalpía y energía de Gibbs de la reacción. 
Constante de equilibrio

Empezaremos determinando el cambio energético 
que  acompaña  a  la  reacción  a  partir  de  cálculos 
independientes de las energías de cada reactivo y cada 
producto. Los datos para optimizar las geometrías de cada reactivo y cada producto se encuentran 
en los ficheros de datos siguientes:

CN-.inp para el anión NC–

FCH3.inp para la molécula CH3F
F-.inp para el anión F– (en este caso no hay optimización)
CH3CN.inp para la molécula NCCH3

Observa la especificación de la carga negativa en los aniones (iCharg=-1). En la especificación 
de la geometría del NCCH3 aparece una línea de más con símbolo atómico “X” que corresponde a 
un punto de referencia en el espacio (un dummy) que se incluye para completar la especificación 
de la geometría molecular. El motivo es que la molécula tiene tres átomos colineales (C-C-N) y, 
si queremos especificar la posición del átomo N a partir de las de los átomos de carbono mediante 
el sistema Z-matrix, nos encontraremos con que no podemos definir su ángulo diedro. Dibuja esta 
molécula indicando la numeración de los átomos. 

Ejecuta  GAMESS  con  cada  uno  de  los  ficheros  de  datos  indicados.  Como los  ficheros  de 
resultados son muy largos es mejor que los abras con el visualizador wxMacMolPlt para localizar 
con  facilidad  los  datos  que  necesitas  (asegúrate  de  que  haya  terminado  el  cálculo  antes  de 

 Las funciones de base difusas tienen la misma expresión matemática que las de valencia pero sus parámetros 3

exponenciales  son  más  pequeños,  lo  cual  hace  que  decrezcan  más  lentamente  con  la  distancia  al  núcleo.  Son 
necesarias  para  obtener  una  buena  descripción  de  especies  aniónicas  y  de  interacciones  intermoleculares.  La 
especificación DiffSP=.T. del fichero de datos hace que se incluya una función difusa por cada OA de valencia s 
o p de todos los átomos excepto los de hidrógeno.
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visualizar los resultados, y clica en NO cuando pregunte si quieres leer los orbitales naturales). 
Anota, con todos los decimales que aparecen, los valores de la energía MP2 correspondientes a 
las geometrías optimizadas de cada molécula (abajo de la ventana en la que aparece dibujada la 

molécula) y del F–. Suma las energías Ue de los reactivos, por un lado, y las de los productos, por 
otro, las cuales determinarán las asíntotas del perfil energético de la reacción.

Abre con el gedit el fichero de resultados del CH3F y, al final, verás unas tablas precedidas 
del  epígrafe  THERMOCHEMISTRY  AT  T=  298.15  K.  Éstas  contienen  información  sobre 
propiedades termodinámicas a 25ºC y 1013,25 hPa, desglosadas en contribuciones electrónica, 
traslacional, rotacional y vibracional, tanto en kJ/mol como en kcal/mol. 

La primera columna (E)  corresponde a la  energía interna molar  de la  especie objeto del 
cálculo (CH3F). Su contribución electrónica (incluida Vnuc) es nula porque se ha adoptado Ue 
como origen de energías y ha supuesto que la población de los estados electrónicos excitados es 
despreciable. Esto es cierto cuando sus energías de excitación son grandes frente a kT,  como 
ocurre para la mayor parte de las moléculas a temperatura ambiente. No obstante, para calcular 
los cambios energéticos en la reacción se han de tener en cuenta las diferencias entre las energías 
Ue  de reactivos y de productos, lo cual exige referirlas a un origen común. El origen que se 
adopta normalmente en los cálculos químico-cuánticos corresponde a un estado en el que núcleos 
y electrones se encuentran infinitamente separados (⟨U⟩ = 0) y en reposo (⟨T⟩ = 0), y es común 
para reactivos y productos. Como todas las moléculas de una misma especie tienen la misma 
energía Ue, la contribución de ésta a la energía interna molar será NAUe. La aplicación GAMESS 
utiliza  expresiones  deducidas  mediante  mecánica  estadística  para  calcular  las  contribuciones 
traslacional  (TRANS.),  rotacional  (ROT.)  y  vibracional  (VIB.),  las  cuales  se  recogen  en  esta 
columna de la tabla junto con su suma (TOTAL). Comprueba que la contribución traslacional es 
(3/2)RT. Esto es cierto para cualquier molécula, como puedes verificar utilizando la expresión de 
la energía interna traslacional en función de ztr  (consulta el formulario). La teoría cinética de 
gases permite justificar este resultado en base a los 3 grados de libertad asociados al movimiento 
traslacional (movimiento a lo largo de 3 ejes perpendiculares). La energía interna rotacional es 
(3/2)RT para moléculas no lineales y RT para las lineales (3 y 2 grados de libertad rotacionales, 
respectivamente).  En  el  caso  de  la  contribución  vibracional  la  cuantización  de  la  energía  es 
demasiado relevante para poder estimar la energía interna a partir de las expresiones clásicas para  
la energía, y los valores calculados no pueden racionalizarse de una manera sencilla en base al 
recuento de grados de libertad.

La segunda columna de la tabla (H) recoge las distintas contribuciones a la entalpía molar (H 
= E + PV) de la especie reaccionante. Como el único movimiento que contribuye a la presión es 
el traslacional, y PV = RT para 1 mol de gas ideal, la contribución traslacional de H será igual a 
la de E más RT (compruébalo). Puedes comprobar también que las contribuciones electrónica, 
rotacional y vibracional de H son iguales a las de E. La entalpía molar referida al origen común 
se obtendrá sumando la contribución electrónica (NAUe) a las otras tres (H TOTAL). Ten en cuenta 
que, como la energía molecular Ue resultante del cálculo HF+MP2 está expresada en hartrees, 
deberás convertirla a kJ para que, una vez multiplicada por el número de Avogadro, produzca un 
resultado en kJ/mol.
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La tercera columna de la tabla (G) recoge las distintas contribuciones a la energía de Gibbs (o 
energía libre) molar: G = H – TS. Como prácticamente todas las moléculas están en su estado 
electrónico fundamental (máximo grado de “orden electrónico”), la contribución electrónica de la 
entropía molar es nula, y la contribución electrónica de G será igual que la de H y que la de E: 
NAUe.

En la tabla aparecen también las contribuciones a las capacidades caloríficas molares (CV y 
CP) y a la entropía molar (S).

Abre  una  hoja  de  cálculo  y  construye  una  tabla  con  la  entalpía,  la  energía  de  Gibbs 
(incluyendo  en  ambos  casos  la  contribución  electrónica)  y  las  distintas  contribuciones  a  la 
entropía de cada especie reaccionante.  Tendrás que coger,  como mínimo, 4 decimales en los 
valores de Ue expresados en hartrees para evitar introducir errores mayores que 0,5 al pasar a kJ/
mol. Calcula la entalpía total de los reactivos y la de los productos e indica si la reacción es 
endotérmica o exotérmica (deberías obtener un valor aproximado de –30,64 kJ/mol para ∆H). 
¿Cómo se desplazará el equilibrio al variar la temperatura?

Calcula  la  energía  de  Gibbs  de  la  reacción  y  determina  la  constante  termodinámica  de 
equilibrio a 298,15 K utilizando la expresión: 

Deberías obtener un valor de unos –21,72 kJ/mol para ∆G0 y una Keq en torno a 6400. Si vas bien 
de tiempo puedes comprobar tu previsión respecto de la variación de la constante de equilibrio 
con  la  temperatura  repitiendo  los  cálculos  para  una  temperatura  diferente  de  298,15  K;  por 
ejemplo, 320 K. Para ello has de incluir la siguiente línea:
 $FORCE TEMP=320 $END
en el fichero de datos de cada especie reaccionante (por ejemplo, al final del fichero).

Comprueba  que  la  entropía  de  la  reacción  es  de  –0,030  kJK–1mol–1  aproximadamente,  e 
indica si el término entrópico de ∆G (–T∆S) favorece o desfavorece la reacción.

b) Perfil energético de la reacción
Para obtener un esbozo del perfil energético de la reacción efectuarás nueve optimizaciones 

restringidas  de  la  supermolécula  (NCCH3F)–  fijando  la  distancia  C-C  en  sucesivos  valores 
decrecientes de 0,25 en 0,25 Å. Empieza con una distancia de 3,5 Å (a la que aún no se ha 
formado el enlace C-C) y termina con 1,5 Å (valor próximo a la distancia C-C en la molécula 
NCCH3).  El  fichero  FCH3CN-.inp  tiene  los  datos  necesarios,  a  falta  de  substituir  el  doble 
interrogante ?? por el valor que quieras dar a la distancia C-C.  Para cada cálculo abre el fichero 4

de resultados con el wxMacMolPlt  y anota, en una hoja de cálculo, la distancia C-C que has 
puesto en el fichero de datos, la energía HF+MP2 correspondiente a la geometría optimizada 
(con  4  decimales),  la  distancia  C–F  (con  3  decimales)  y  uno  de  los  ángulos  FCH (con  un 
decimal). Para ver los valores de estas coordenadas haz que el programa identifique los átomos 
(View  —>  Atom  Labels  —>  Atom  Number)  y  selecciona  Subwindow  —>  Z-Matrix 

Keq = e−ΔG0 RT

 La presencia de más de 2 átomos alineados ha llevado a introducir un dummy en la especificación de la geometría 4

en coordenadas internas, lo cual –debido a una particularidad del GAMESS– obliga a redefinir estas coordenadas 
mediante el bloque $ZMAT…$END para poder especificar la coordenada que se ha de fijar.
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Calculator. Representa las energías HF+MP2 obtenidas para cada distancia C-C en función de 
la diferencia “distancia C-C – distancia C-F”. Incluye también en la gráfica 2 puntos extremos 
para representar la energía de los reactivos y la de los productos calculadas en la cuestión a) 
(aunque las distancias C-C de los reactivos y C-F de los productos deberían ser infinitas, puedes 
asignarles un valor de 5 Å para poder incluirlas en la gráfica). La representación que obtendrás es 
la proyección del perfil energético de la reacción sobre un plano vertical que corta al horizontal 
por la recta punteada de la figura 4. Analiza e interpreta los cambios energéticos y geométricos 
que acompañan a la reacción.

c) Estado de transición
El máximo que presenta el perfil de la reacción corresponde al estado de transición, que es 

un punto de silla (saddle point)  de la función U.  Aunque éste no es un extremo (máximo o 

mínimo) es un punto estacionario y, por lo tanto, de gradiente ( � ) nulo. Para precisar mejor la 
geometría de la supermolécula en este punto debe minimizarse la norma del vector �  partiendo 
de  una  geometría  lo  más  próxima  posible  a  del  punto  buscado.  Para  llevar  a  cabo  esta 
minimización  debes  poner  RUNtyp=sadPoint  en  la  primera  línea  del  fichero  de  datos 
FCH3CN-.inp,  asignar a las distancias C-C y C-F los valores que corresponden al punto más 
elevado del perfil (2.00 y 2.15 Å respectivamente). En la línea que comienza por $STATPT tendrás 
que eliminar la indicación iFreez(1)=10 para que se optimice también la distancia C-C, poner 
Hess=Calc para que se calcule la matriz hessiana de U para la geometría de partida, y añadir la 
opción HssEnd=.T. para que se calculen los modos normales y las magnitudes termodinámicas al 
final de la optimización (este cálculo durará bastante más que los anteriores). Ten en cuenta que, 
en general, la localización de estados de transición es una tarea bastante más complicada de lo 
que este sencillo ejemplo pueda sugerir. Ejecuta el GAMESS con estos datos y anota la energía de 
Gibbs correspondiente al punto de silla (SADDLE POINT LOCATED) y las distancias C-C y C-F. 
Compara las distancias C-F y C-C del estado de transición con sus valores en las geometría de 
equilibrio de las moléculas CH3F y NCCH3. Verás que corresponden a un estado en el que se ha 
iniciado la ruptura del enlace C-F de la primera al tiempo que se ha comenzado a formar el enlace 
C-C de la segunda. Añade este punto a la gráfica del perfil de reacción. 

En un estado de  transición la  función U  es  mínima respecto  de  todas  las  coordenadas 
normales excepto la de reacción y, en consecuencia, su matriz hessiana tendrá todos sus valores 
propios λi positivos salvo uno que será negativo. El modo normal correspondiente no representa 
una vibración, ya que la energía disminuye al deformar la supermolécula de acuerdo con dicho 
movimiento, y ésta evolucionará hacia los reactivos o hacia los productos. El programa GAMESS 
no nos muestra los valores propios de la hessiana, sino sus raíces cuadradas divididas por 2πc, 
que, cuando el valor propio es positivo, representan números de ondas vibracionales:

 ∇
!"
U

 ∇
!"
U

ν i =
1

2πc
λi  con λi =

∂2U
∂Qi
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Si λi  es negativo el valor de  será imaginario, lo cual se indica en el fichero de resultados 
mediante una ‘I’ a continuación del dato numérico. Aunque, en este caso, �  no representa una 
frecuencia propiamente dicha, se le suele llamar “frecuencia imaginaria”. 

Mira el análisis de los modos normales que hay al final del cálculo del estado de transición. 
El primer modo es el de frecuencia imaginaria. Visualízalo mediante el wxMacMolPlt. Como en 
el caso de las traslaciones y las rotaciones, la opción Animate Mode del menú View representa 
dicho modo como una vibración, aunque, en realidad, no existe fuerza recuperadora que produzca 
tales oscilaciones. Los 6 modos siguientes representan las traslaciones y las rotaciones, y los 
demás corresponden a vibraciones propiamente dichas. Es importante comprobar que hay una 
única frecuencia imaginaria para tener la seguridad de que la estructura hallada corresponde a un 
estado de transición.

d) Energía de Gibbs de activación. Constante de velocidad
A partir de las energías de Gibbs de los reactivos y del estado de transición calcula la energía 

de Gibbs de activación (∆G⧧) y la constante de velocidad de la reacción a 298,15 K y 1013,25 
hPa utilizando la ecuación de Eyring: 

�

donde kB es la constante de Boltzman y c0 es una concentración de referencia que puede tomarse 
igual a 1 mol/l. Deberías obtener ∆G⧧ ≈ 83,64 kJ/mol y k(298,15 K) ~ 0,014 mol–1 l s–1.

e) Complejos de reactivos y de productos
El perfil obtenido en b) pone de manifiesto que, al acercarse el anión NC– a la molécula 

CH3F, ambos reactivos forman un complejo –estabilizado por interacciones de tipo ion-dipolo 
principalmente– ya que la función U presenta un mínimo a una distancia C-C grande comparada 
con los valores típicos del enlace C-C. Optimiza la geometría de este mínimo (fichero de datos 
FCH3CN-.inp) partiendo de una distancia C-C próxima al mínimo (por ejemplo, 3.0 Å) y una 
distancia C-F próxima a la de equilibrio (por ejemplo 1.4 Å).  En la línea que comienza por 
$STATPT puedes quitar la opción Hess=Calc (el cálculo previo de la matriz hessiana es costoso, y 
no  suele  ser  necesario  para  la  localización  de  mínimos  de  energía),  pero  deja  la  opción 
HssEnd=.T. para que puedas comprobar el carácter de mínimo de la geometría obtenida.

Observa que la  geometría  de cada reactivo en el  complejo es  muy parecida a  la  de las 
moléculas aisladas, como corresponde a una asociación intermolecular. 

Los  productos  también forman un complejo  de  este  tipo.  Compruébalo  optimizando la 

geometría del (NCCH3F)– a partir de unas distancias C-C y C-F de 1.4 y 3.0 Å respectivamente. 

f) Comprobación del carácter de mínimo de los complejos
Los algoritmos de optimización geométrica pueden conducir a puntos estacionarios de U que 

no sean mínimos; por ejemplo, puntos de silla o máximos respecto de más de una coordenada. En 
tal caso, la matriz hessiana de U tendría uno o más valores propios negativos.

ν i

ν i

 k(T ) = kBT
hc0 e−ΔG

‡ RT
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Mira si las geometrías obtenidas en el apartado anterior para los complejos de reactivos y de 
productos  corresponden  a  verdaderos  mínimos.  Verás  que  el  complejo  de  productos  tiene  2 
modos  de  frecuencia  imaginaria,  que  deforman la  geometría  colineal  CCF acercando el  F  a 
alguno de los  Hs.  Para encontrar  el  verdadero mínimo tendrás  que distorsionar  la  geometría 
inicial  desplazando  el  F  hacia  alguno  de  los  Hs  y  repetir  la  optimización.  Puedes  hacerlo 
mediante el wxMacMolPlt: Builder  -> Show Toolbar  -> Select  -> Clic en el F -> Edit  -> 
Arrastrar el F hacia uno de los H -> Subwindow  -> Input Builder  -> Write File  (pon un 
nombre  con  extensión  .inp).  Optimiza  la  nueva  geometría,  comprueba  que  has  obtenido  un 
verdadero mínimo y representa el resultado. Interpreta el cambio geométrico que se ha producido 
teniendo en cuenta que el F– es un anión monoatómico.

Añade a la gráfica del perfil de reacción los puntos correspondientes a los complejos de 
reactivos y de productos. A partir de las energías de éstos y de los resultados de la cuestión a) 
calcula la energía de Gibbs de estabilización de cada complejos (energía del complejo – suma de 
las energías de los reactivos o de los productos) a 298,15 K. 
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Práctica 5: UTILIZACIÓN DE LA APLICACIÓN GRÁFICA GABEDIT

El objetivo de esta práctica es aprender a utilizar la aplicación GABEDIT,–herramienta gráfica 
más compleja pero más versátil  que el wxMacMolPlt– que permite generar ficheros de datos, 
ejecutar cálculos y visualizar resultados de la aplicación GAMESS y de otros programas de cálculo 
químico-cuántico. Este programa está en el menú Applications > QFIII. Seguiremos un ejemplo 
guiado propuesto por el autor del programa, Abdulrahman Allouche, en el apartado tutorials de la 
página  web  de  documentación  del  GABEDIT  (http://sites.google.com/site/allouchear/Home/
gabedit/documentations). Puedes explorar otras opciones de esta aplicación dejando un segundo 
el puntero sobre diferentes iconos para que aparezca una breve explicación de su función.  

5.1 Geometry optimization of H2O

a) Building the molecule
1.Open Gabedit and Click on the Draw Geometry button.

�
2. On Drawing (grey) area click with right button of mouse, select Add > Add a fragment > 
Miscellaneous > Water, and click again into the grey area. You have successfully built the chosen 
structure: 

b) Optimizing the geometry with HF method
1. Close the Draw Geometry window.
2. Click on New Gamess input file.

�

http://sites.google.com/site/allouchear/Home/gabedit/documentations
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3. Select Equilibrium geometry for Run Type (geometry optimization).
4. Select RHF method.
5. Select 6-31G Basis set.

6. Click to OK button. 
7. Click to Run a program button.

�
8. Select a Folder and type H2O_HF at Save data file text zone

9. Click to OK button.. Gamess starts at background job
10. Select H2O_HF.log at the top of the the main window.
11. Click to Update/End button for reloading the output file.
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12. When the job completes click to Geom. Conv.
13. Click to Draw 

14. See intermediate geometries by clicking on other points of the energy curve. Select the last 
point. 
15. Click on the Draw Geometry area with right button and select Labels > Numbers. 
16. Click to Measure button and select the H, O and H atoms to see the values of the internal 
coordinates. 

c) Optimizing the geometry with DFT-B3LYP method
1.Close geometry windows.
2.Click on New Gamess input file 

�
3. Select Equilibrium geometry for Run Type.
4. Select Density Functional Theory for Correlation type. 
5. Select 6-31G for Basis set. 



!  35

6. Click to OK button. 
7. Click to Run a program button. 

�
8. At Save data in file type H2O_B3LYP 
9. Click to OK button. 
10. Gamess starts at background job. 
11. Select H2O_B3LYP.log and click to Update/End for reloading the output file.
12. When the job completes click to Geom. Conv. 
13. Click to Draw.

d) Visualizing the orbitals and the electronic density
1. Close geometry windows.
2. Click to Display Geometry/Orbitals/Density/Vibration button.

�
3. Right click on the black window, select Orbitals > Read geometry and orbitals from a Gamess 
output file and then H2O_B3LYP.log and click Open.
4. The HOMO is automatically selected. Click OK and OK again in the two appearing windows 
to visualize this orbital.
5. Click to the Optimal Camera button.
You can easily change the display type 
by right clicking on the window and 
selecting the type of rendering: Render 
> Geometry and/or Render > Surface, 
etc.
6. Right click on the window and select 
Surfaces > Delete all, then Density > 
Electronic. Click to OK (two times) 
and choose 0.1 for the isovalue. For 
smaller values the surface is larger and 
you should increase the size of the box 
containing the picture.
7. Right click and select Orbitals 
Slideshow. 
10. Select several orbitals and click to 
OK.
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5.2 Infrared spectrum of 2-azido-propane (isopropylazide)

So as  to  further  practice  with  the  molar  editor  we will  build  a  preliminar  structure  for  this 
molecule:

a) Building the molecule
1. Exit Gabedit and open it again.
2. Click on Draw geometry button.
3. Right click on the gray zone, select Add > Add a fragment > Functionals > Isopropyl and click 
to the gray zone.

4. Select the Rotation button (upper left zone of the window). See the notes at the bottom of 
window (move the mouse while holding down the left button to rotate). 

5. Select the Translation button (upper left zone of the window). See the notes at the bottom of 
window (move the mouse while holding down the left button to translate; move the mouse while 
holding down the middle button to rotate).
6. Select the Zoom button (upper left zone of the window). See the notes at the bottom of window 
(move the mouse while holding down the left button to zoom).
7. Select the Measure button (left of the window):
- Right click and select Labels > Symbols&Numbers.
- Right click and select Labels > Distances.
- Select one, two, three or four atoms. The distance, angle and dihedral angle are displayed on the 
right of the window.

8. Orient the molecule with the C2 rotation axis perpendicular to the screen and the CH2 pointing 
to you.
7. Select the Insert/Change atoms or bond button (a pencil).
- Deactivate the Adjust hydrogens button.
- Click on the Set atom to insert button (periodic table) and select Nitrogen.
- Click on one hydrogen atom connected to the central carbon. The hydrogen atom is replaced by 
N atom (N1).

8. Select the Measure button. Select the two atoms of the C-N bond and put them at a distance of 
1.4 Å by writing this number in the Distances box and press the Return key.



!  37

9. Select the Insert/Change atoms or bond. Click on the N1 atom and drag to add a second N 
atom (N2) and leave it on the HCN plane. Select the Measure button; select the two N atoms and 
put them at a distance of 1.2 Å by writing this number in the Distances box and typing Return.
10. Select the Insert/Change atoms or bond, add a third N3 atom and leave it on the HCNN plane. 
Select the Measure button, select the atoms N2 and N3 and put them at a distance of 1.1 Å.

b) Visualizing the normal modes and the infrared spectrum
1. Close the Draw Geometry window and click on the New Gamess input file button.
2. Select RHF at the SCF Type frame.
3. Select STO-3G at the Basis set frame.
4. Select Equilibrium geometry at the Run Type frame. Click to OK.
5. Using gabedit text editor to insert the line (it begins with a space character):

 $STATPT NSTEP=60 HSSEND=.T. $END
6. Click to Run a program button.
7. Type azid_HF_STO3G at Save data in file and click to OK. Gamess starts at background job.
8. Select azid_HF_STO3G.log and click to Update/End for reloading the output file. Look for the 
information about the enthalpy and the Gibbs free energy (you can search using the Find a string 
button; the searching is case selective). 
9. Click to the Geom. Conv. button and to Draw.
10. Since we have included the option HSSEND=.T. we can visualize the vibrational normal 
modes and simulate the IR spectrum. Close the Geometry convergence window and click to the  
Display  Geometry/OrbitalDensity/Vibration  button.  Right  click  on  the  window  and  select 
Animation > Vibration. On the Vibration window click the File menu and select Read > Read 
Gamess output file > Open. To better visualize the normal modes you can modify the rendering 
with right-click in the window and select Render > Geometry > Wireframe. Select a normal mode 
and click on the Play button to animate it. In the Tools menu select Draw IR Spectrum to simulate 
the infrared spectrum.
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Apéndice 1: REPRODUCCIÓN DE UN CÁLCULO PUBLICADO

A continuación se indican los títulos y las direcciones de las páginas web de una 
serie de artículos del Journal of Chemical Education que contienen estudios químico-
cuánticos no muy complicados que deberías ser capaz de reproducir con la experiencia 
adquirida en las prácticas anteriores. Te proponemos que escojas alguno de los artículos 
e intentes reproducir los cálculos descritos.

Para  descargar  los  artículos  tienes  que  clicar  en  el  enlace  correspondiente  y, 
cuando la web de la revista te pida un usuario y contraseña para descargar el fichero pdf, 
clica en el botón del navegador que pone Accés recursos-e CRAI UB  e introduce tu 
código y contraseña del Espai Personal de la U.B.

1.-  Computational  Studies  of  Chemical  Reactions:  The  HNC–HCN  and  CH3NC–
CH3CN Isomerizations.

http://jchemed.chem.wisc.edu/Journal/Issues/2006/Jan/PlusSub/V83N01/p69.pdf

2.- Predicting the Stability of Hypervalent Molecules.

http://jchemed.chem.wisc.edu/Journal/Issues/2007/Apr/jceSubscriber/p629.pdf

3.- The Inversion Potential of Ammonia: An Intrinsic Reaction Coordinate Calculation 
for Student Investigation.

http://jchemed.chem.wisc.edu/Journal/Issues/2007/Jun/jceSubscriber/p1067.pdf

4.-  Mechanisms of  Pentacoordinate  Pseudorotation:  A Molecular  Modeling Study of 
PF5.

http://jchemed.chem.wisc.edu/Journal/Issues/2001/Jun/PlusSub/V78N06/p844.pdf

5.- Quantitative Thermodynamic Descriptions of Aromaticity: A Computational Exercise 
for the Organic Chemistry Laboratory.

http://jchemed.chem.wisc.edu/Journal/Issues/2005/Jun/PlusSub/V82N06/p953.pdf

6.-  Educational  Applications  of  IR  and  Raman  Spectroscopy:  A  Comparison  of 
Experiment and Theory.

http://jchemed.chem.wisc.edu/Journal/Issues/2000/May/PlusSub/V77N05/p654.pdf

7.-  The Oxalate Dianion, C2O42-: Planar or Nonplanar? 

https://pubs-acs-org.sire.ub.edu/doi/pdf/10.1021/ed200202r 

http://jchemed.chem.wisc.edu/Journal/Issues/2006/Jan/PlusSub/V83N01/p69.pdf
http://jchemed.chem.wisc.edu/Journal/Issues/2007/Apr/jceSubscriber/p629.pdf
http://jchemed.chem.wisc.edu/Journal/Issues/2007/Jun/jceSubscriber/p1067.pdf
http://jchemed.chem.wisc.edu/Journal/Issues/2001/Jun/PlusSub/V78N06/p844.pdf
http://jchemed.chem.wisc.edu/Journal/Issues/2005/Jun/PlusSub/V82N06/p953.pdf
http://jchemed.chem.wisc.edu/Journal/Issues/2000/May/PlusSub/V77N05/p654.pdf
https://pubs-acs-org.sire.ub.edu/doi/pdf/10.1021/ed200202r
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Apéndice 2: FICHEROS DE DATOS DE LAS PRACTICAS 1 A 4

Práctica 1

Fichero HCl.inp

 $CONTRL SCFtyp=RHF RUNtyp=Energy
         Coord=Zmt iCharg=0 
 $END
 $SYSTEM MWords=100 $END
 $BASIS  GBasis=STO nGauss=3 $END 
 $GUESS  Guess=Huckel $END
 $DATA
Cálculo HF/STO-3G del HCl a geometría fija 
C1  0
Cl
H  1  1.3
 $END

Fichero HCl_CI.inp

 $CONTRL SCFtyp=RHF RUNtyp=Energy
         Coord=Zmt iCharg=0 CItyp=Guga
 $END
 $SYSTEM MWords=100 $END
 $BASIS  GBasis=STO nGauss=3 $END
 $GUESS  Guess=Huckel $END
 $CIDRT iExcit=2 nFzC=6 nDOc=3 nVal=1 $END
 $DATA
Cálculo CI/STO-3G del HCl a geometría fija 
C1  0
Cl
H  1  4.0
 $END

Práctica 2

Fichero H2O.inp

 $CONTRL SCFtyp=RHF RUNtyp=Optimize 
         Coord=Zmt iCharg=0 Local=Boys 
 $END
 $SYSTEM MWords=100 $END
 $BASIS  GBasis=STO nGauss=3 $END 
 $GUESS  Guess=Huckel $END
 $DATA
Opt. geométrica HF/STO-3G del H2O (con localización de los OMs)
C1  0
O
H  1  1.0
H  1  1.0  2  105.0
 $END



!  40

Fichero C2H6.inp

 $CONTRL SCFtyp=RHF RUNtyp=Optimize 
         Coord=Zmt iCharg=0 nzVar=18
 $END
 $SYSTEM MWords=100 $END
 $BASIS  GBasis=STO nGauss=3 $END 
 $GUESS  Guess=Huckel $END
 $DATA
Opt. HF/STO-3G del C2H6 para un ángulo de rotación interna fijo
C1  0
C
C  1  1.5
H  1  1.0  2  100.0
H  1  1.0  2  100.0  3 120.0
H  1  1.0  2  100.0  4 120.0
H  2  1.0  1  100.0  3 ??
H  2  1.0  1  100.0  6 120.0
H  2  1.0  1  100.0  7 120.0
 $END
 $STATPT iFreez(1)=12 $END

Práctica 3

Fichero H2O_HF.inp

 $CONTRL SCFtyp=RHF RUNtyp=Hessian
         Coord=Zmt iCharg=0
 $END
 $SYSTEM MWords=100 $END
 $BASIS  GBasis=n31 nGauss=6 ndFunc=1 npFunc=1 $END 
 $GUESS  Guess=Huckel $END
 $DATA
Modos normales HF/6-31G(d,p) del H2O (geometría optimizada)
Cnv  2

O
H  1 0.9430581
H  1 0.9430581  2 105.9678471
 $END

Fichero H2O_MP2.inp

 $CONTRL SCFtyp=RHF RUNtyp=Optimize MPlevl=2 
         Coord=Zmt iCharg=0
 $END
 $SYSTEM MWords=100 MemDDI=20 $END
 $BASIS  GBasis=n31 nGauss=6 ndFunc=1 npFunc=1 $END 
 $GUESS  Guess=Huckel $END
 $STATPT nStep=30 HssEnd=.T. $END
 $DATA
Modos normales MP2/6-31G(d,p) del H2O con opimización de geometría 
Cnv  2
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O
H  1 1.0
H  1 1.0  2 105.0
 $END

Fichero CO2_HF.inp

 $CONTRL SCFtyp=RHF RUNtyp=Hessian
         Coord=prinAxis iCharg=0
 $END
 $SYSTEM MWords=100 $END
 $BASIS  GBasis=n31 nGauss=6 ndFunc=1 $END 
 $GUESS  Guess=Huckel $END
 $DATA
Modos normales HF/6-31G(d) del CO2 (geometría optimizada)
Dnh  4

C  6   0.0  0.0  0.0
O  8   0.0  0.0 -1.1432564937
O  8   0.0  0.0  1.1432564937
 $END

Práctica 4

Fichero F-.inp

 $CONTRL SCFtyp=RHF RUNtyp=Hessian iCharg=-1
         MPlevl=2 
 $END
 $SYSTEM MWords=100 MemDDI=20 $END
 $BASIS  GBasis=N31 nGauss=6 ndFunc=1 DiffSP=.T.  $END
 $GUESS  Guess=Huckel $END
 $DATA
Cálculo del F-
C1
F  9  0. 0. 0.
 $END

Fichero CH3CN.inp

 $CONTRL SCFtyp=RHF RUNtyp=optimize 
         Coord=Zmt iCharg=0
         MPlevl=2
 $END
 $SYSTEM MWords=100 MemDDI=20 $END
 $BASIS  GBasis=N31 nGauss=6 ndFunc=1 DiffSP=.T. $END 
 $GUESS  Guess=Huckel $END
 $DATA
Optimización del CH3CN
C1
C
C  1  1.2
H  2  1.1  1  104.0  
H  2  1.1  1  104.0  3 120.0
H  2  1.1  1  104.0  4  120.0
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X  1  1.0  2   90.0  3    0.0
N  1  1.15 6   90.0  2  180.0
 $END
 $STATPT nStep=60 HssEnd=.T. $END

Fichero FCH3.inp

 $CONTRL SCFtyp=RHF RUNtyp=optimize 
         Coord=Zmt  iCharg=0 
         MPlevl=2 
 $END
 $SYSTEM MWords=100 MemDDI=20 $END
 $BASIS  GBasis=N31 nGauss=6 ndFunc=1 DiffSP=.T. $END
 $GUESS  Guess=Huckel $END
 $DATA
Optimización del FCH3
C1
F
C  1  1.4
H  2  1.1  1  105.0  
H  2  1.1  1  105.0  3  120.0
H  2  1.1  1  105.0  4  120.0
 $END
 $STATPT nStep=60 HssEnd=.T. $END

Fichero CN-.inp

 $CONTRL SCFtyp=RHF RUNtyp=optimize
         Coord=Zmt iCharg=-1
         MPlevl=2
 $END
 $SYSTEM MWords=100 MemDDI=20 $END
 $BASIS  GBasis=N31 nGauss=6 ndFunc=1 DiffSP=.T. $END
 $GUESS  Guess=Huckel $END
 $DATA
Optimización del CN-
C1
N
C  1  1.15
 $END
 $STATPT nStep=60 HssEnd=.T. $END

Fichero FCH3CN-.inp

 $CONTRL SCFtyp=RHF RUNtyp=optimize
         Coord=Zmt iCharg=-1 nzVar=15
         MPlevl=2
 $END
 $SYSTEM MWords=100 MemDDI=20 $END
 $BASIS  GBasis=N31 nGauss=6 ndFunc=1 DiffSP=.T. $END
 $GUESS  Guess=Huckel $END
 $DATA
Optimización del (FCH3CN)- para rCC fija
C1
F
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C  1  1.41
H  2  1.1  1  90.0  
H  2  1.1  1  90.0  3  120.0
H  2  1.1  1  90.0  4  120.0
C  2  ??   3  90.0  1  180.0
X  6  1.0  2  90.0  3    0.0
N  6  1.2  7  90.0  2  180.0
 $END
 $STATPT  nStep=60  iFreez(1)=10  $END 
 $ZMAT   iZmat(1)=
         1,   2,   1,
         1,   3,   2,
         2,   3,   2,   1,
         1,   4,   2,
         2,   4,   2,   1,
         3,   4,   2,   1,   3,
         1,   5,   2,
         2,   5,   2,   1,
         3,   5,   2,   1,   4,
         1,   6,   2,
         2,   6,   2,   3,
         3,   6,   2,   3,   1,
         1,   7,   6,
         2,   7,   6,   3,
         3,   7,   6,   3,   1,
 $END


